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Using the Manuals
Four different manuals have been prepared for your CP4 STAGE or CP40 STAGE — the Owner’s Manual, this
Reference Manual, the Synthesizer Parameter Manual, and the Data List. A hard-copy version of the Owner’s
Manual comes together with the instrument, and the other three manuals are provided as pdf files on the
Yamaha Downloads web page.

Owner’s Manual (hardcopy booklet)
The Owner’s Manual describes how to set up your CP4 STAGE or CP40 STAGE and perform basic
operations. In specific terms, it covers the following:
•
•
•
•
•
•
•
•
•
•
•
•
•

Setting up
Basic operations and display content
Performances
Playing Voices
Layering Voices
Splitting the keyboard for left and right hands
Practicing with the metronome
Changing the sound using controllers
Raising or lowering the pitch of keyboard notes
Storing settings
Selecting a Performance
Creating your own Performances
Recording your playing as audio

•
•
•
•
•
•
•
•
•
•
•
•

Playing audio files
File operations using a USB flash-memory device
Configuring utility settings for the overall system
Using with a computer
Using with a portable music player
Using with other MIDI devices
Shift functions
On-screen messages
Troubleshooting
Specifications
Index
Introduction to Yamaha services

Reference Manual (this pdf document)
This Reference Manual describes the design of the CP4 STAGE and CP40 STAGE and all of the parameters
that may be set.

Synthesizer Parameter Manual (pdf document)
The Synthesizer Parameter Manual provides a description of Voice parameters, effect types, effect
parameters, and MIDI messages often used on Yamaha electronic instruments. We recommend that you first
read the Owner’s Manual and this Reference Manual, and then refer to the Synthesizer Parameter Manual if
you wish to know more about a specific Voice parameter, effect, or the like.

Data List (pdf document)
The Data List provides tables of the Voices, Performances, and effects found on the CP4 STAGE and CP40
STAGE in addition to MIDI-related content.

Using this Reference Manual
• A hierarchical list of functions is provided on the right-hand side of each page from the Reference section of this
manual. To jump to a description of any function, click the corresponding entry in the list. In addition, the functions
described on the current page are shown by red dots () in front of the corresponding entries in the list.
• By clicking a page number from the Table of Contents or links provided within descriptions, you can jump to the
corresponding page.
• You can also jump directly to individual pages by clicking the bookmarks displayed on the left in your pdf viewer. (If no
bookmarks are shown, click the Bookmarks tab in the left margin.)
• If you select either Find or Search from the Edit menu in Adobe® Reader®, you can enter a keyword and search for it
within the entire document.
NOTE The most-recent version of Adobe® Reader® can be downloaded from the following web page:
http://www.adobe.com/products/reader/
NOTE Menu names and display positions may vary depending on the version of Adobe® Reader® you are using.
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Using the Manuals

Note regarding diagrams
• The illustrations and screens shown in this manual are for instructional purposes only and may differ somewhat for your
particular instrument or computer.
• Windows is a registered trademark of Microsoft® Corporation in the United States and other countries.
• Apple, Mac, Macintosh, iPad, iPhone, and iPod touch are trademarks of Apple Inc. registered in the United States and
other countries.
• Other company and product names used in this manual are the trademarks or registered trademarks of their
respective companies.

Terms
 Screen names
•
•
•
•
•

The Performance screen is the screen displayed immediately after the instrument is turned on.
The Edit menu is the first screen displayed when the [EDIT] button is pressed.
The Store screen is the first screen displayed when the [STORE] button is pressed.
The File menu is the first screen displayed when the [FILE] button is pressed.
The Utility menu is the first screen displayed when the [UTILITY] button is pressed.

 Confirmation popup
Before executing various functions, the instrument will display the Confirmation popup shown below to
confirm that you wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the
function or the [-1/NO] button to return to the previous screen without doing so.
Confirmation popup

Are you sure?
[NO]/[YES]

Exiting from the current screen
You can press the [EXIT] button to move one step back in the instrument’s menu structure. Pressing the
[EXIT] button multiple times or pressing it while holding down the [SHIFT] button will return you to the
Performance screen.
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Design of the CP4 STAGE & CP40 STAGE
Makeup
In terms of sound production, the CP4 STAGE and CP40 STAGE each comprises three blocks — namely, the
controllers, the tone generator, and the effect unit.
Controllers

Tone generator

Effect unit

Controllers
In order that it may be played, the instrument features a range of controllers such as the keyboard, pitch
bend wheel, modulation wheel, and sliders. Performance data reflecting the pitch of each key played and
the velocity (or strength) with which it was played is sent to the tone generator in the form of MIDI messages.
Data generated by operating the wheels, sliders, pedals, and the like is also sent in the same way.

Keyboard
The keyboard is the main controller used to send performance information to the tone generator. Using the
[-] and [+] TRANSPOSE buttons, you can change the pitches of the keys in semitone units.

Pitch Bend Wheel
The pitch bend wheel can be used to control the pitch of played
notes in a continuously variable manner. Notes are bent upward
when you push the pitch bend wheel away from you and vice
versa. When you release this wheel, the finger slot at the center will
automatically spring back to the original position, and the pitch will
return to normal. The pitch-bend range — that is, the degree to
which pitches can be varied using this wheel — can be set on the
Play Mode screen (page 17) from the Performance Part Edit area.

Notes are bent
upward

Notes are bent
downward

In addition to pitch bending, you can also assign control of an
insertion effect (page 11) parameter to the pitch bend wheel. To do
so, use the Controller screen (page 21) from the Performance Part
Edit area.

Modulation Wheel
The modulation wheel is normally used to add vibrato and other
suitable effects to the played notes. The more the finger slot is
pushed away from you, the greater the intensity of the effect and
vice-versa. The effect is, therefore, minimized when the slot is
closest to the front of the instrument. If you do not want to apply the
modulation wheel’s effect, it should be returned to this position.
In addition to applying modulation, you can also assign control of a
parameter from an insertion effect (page 11) to the modulation
wheel. To do so, use the Controller screen (page 21) from the
Performance Part Edit area.
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Effect becomes
more intense

Effect becomes
less intense

Design of the CP4 STAGE & CP40 STAGE > Controllers

Sliders
The CP4 STAGE and CP40 STAGE are each equipped with two sets of sliders — the Part sliders and the
MASTER EQUALIZER (EQ) sliders.

Part sliders
Located on the left of the control panel, the Part sliders are used to adjust parameter levels for individual
Parts. There is one slider for each of the instrument’s Parts, and they can be used to adjust three parameters
— volume, chorus send, and reverb send. To change the parameter currently being adjusted, press the
[SLIDER FUNCTION] button located to the right of the sliders the required number of times. Moving the
sliders away from you increases the level of the current parameter and vice-versa.
NOTE For more details on using the Part sliders, refer to the Quick Start Guide section of the Owner’s Manual.
NOTE Operating the Part sliders also changes the settings of the Volume, ChoSend, and RevSend parameters from the Performance
Part Edit area’s Play Mode screen (page 17).

Parameter level increases

Parameter level decreases
(Illustration shows the CP4 STAGE.)

MASTER EQ sliders
The master EQ is used to adjust the overall tone of the instrument, and the MASTER EQ sliders control the
gain in individual frequency bands. Located on the right of the control panel, each of these sliders is
assigned to a different frequency band. Moving a slider away from you increases the gain in the
corresponding frequency band and vice-versa.

Gain increases

Gain decreases
(Illustration shows the CP4 STAGE.)
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Design of the CP4 STAGE & CP40 STAGE > Controllers

Pedals
Two different types of pedal can be used with the CP4 STAGE and CP40 STAGE — foot switches, such as
the bundled FC3A and the optional FC4A and FC5, and a foot controller like the optional FC7.

Foot switches
The FC3A that comes with your CP4 STAGE or CP40 STAGE should be connected via the [SUSTAIN] FOOT
SWITCH jack. This allows it to be used in the same way as the damper pedal of an acoustic piano, causing
the notes played on the keyboard to sustain for longer. Instead of having the foot switch simply turn damping
on and off, you can also have the amount of sustain change depending on how much the pedal is operated.
This setting is made on the Controller screen (page 43) from the Utility area. Configured in this way, the piano
will produce longer notes when the foot switch is operated by a greater amount and vice-versa.
NOTE By default, the Sustain parameter from the Utility area’s Controller screen is set to “FC3 Half On”.

The FC4A and FC5 (sold separately) can be connected via the [ASSIGNABLE] FOOT SWITCH jack so that
various functions can be assigned to them. For example, on the Controller screen (page 21) from the
Performance Part Edit area, you can assign on/off switching of an insertion effect (page 11) to one of these
foot switches. Alternatively, you can assign a MIDI control change number to an FC4A or FC5 on the
Controller screen (page 43) from the Utility area. The foot switch will then control the corresponding
parameter when operated. It should be noted that the FC4A or FC5 can also be connected via the
[SUSTAIN] FOOT SWITCH jack.

Foot controller
The FC7 Foot Controller (sold separately) can be used to control an assigned parameter: On the CP4
STAGE, the FC7 can be connected via the [1] and [2] FOOT CONTROLLER jacks; on the CP40 STAGE, it
can be connected via the [FOOT CONTROLLER] jack. For example, on the Controller screen (page 21) from
the Performance Part Edit area, you could assign control of a Part’s volume or a parameter from one of the
insertion effects (page 11). Alternatively, you could assign a MIDI control change number to an FC7 on the
Controller screen (page 43) from the Utility area. The corresponding parameter can then be controlled by
operating the foot controller.

(Illustration shows the CP4 STAGE.)
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Design of the CP4 STAGE & CP40 STAGE > Tone Generator

Tone Generator
The tone generator produces sound based on data received from controllers such as the keyboard and
sliders. The basic element of CP4 STAGE and CP40 STAGE sounds is referred to as a Voice, and
Performances are made up of multiple Voices. Both the Voice and the Performance are described below.

Voices
Each Voice represents a different instrument sound that the CP4 STAGE or CP40 STAGE can produce.
Generally speaking, your stage piano can produce two different types of Voice — Normal and Drum.
NOTE A full list of your instrument’s Voices can be found in the Data List (pdf).

Normal Voices
Normal Voices are primarily used to reproduce the sound of instruments played within a specific musical
scale. That is to say, the pitch of these Voices will change based on the key played.

Drum Voices
Drum Voices are generally used to produce the sounds of percussion instruments. With these Voices, a
different drum or percussion instrument sound is assigned to the various keys on the keyboard. For this
reason, Drum Voices can also be referred to as drum kits.
One Drum Voice (or Drum Kit)

Different percussion
sound for each key
(Illustration shows a typical Drum Voice.)

Voice categories
The various different Voices on your CP4 STAGE or CP40 STAGE are arranged into a number of categories.
Each category represents a different type of instrument, such as piano or organ, or a sound genre. The
following table shows these categories, and each contains a number of different Voices.
Category
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On-screen abbreviation

Button abbreviation

Voice type(s)

Acoustic Piano 1

AP1 (CP4 STAGE)/
AP (CP40 STAGE)

A.PIANO1 (CP4 STAGE)/
A.PIANO (CP40 STAGE)

Normal

Acoustic Piano 2 (CP4 STAGE only)

AP2 (CP4 STAGE only)

A.PIANO2 (CP4 STAGE only)

Normal

Acoustic Piano 3 (CP4 STAGE only)

AP3 (CP4 STAGE only)

A.PIANO3 (CP4 STAGE only)

Normal

Electric Piano 1

EP1 (CP4 STAGE)/
EP (CP40 STAGE)

E.PIANO1 (CP4 STAGE)/
E.PIANO (CP40 STAGE)

Normal

Electric Piano 2 (CP4 STAGE only)

EP2 (CP4 STAGE only)

E.PIANO2 (CP4 STAGE only)

Normal

Electric Piano 3 (CP4 STAGE only)

EP3 (CP4 STAGE only)

E.PIANO3 (CP4 STAGE only)

Normal

Clav

CLV

CLAV

Normal

Organ

ORG

ORGAN

Normal

Chromatic Percussion

CP

CH.PERC

Normal

Strings

STR

STRINGS

Normal

Choir

CHO

CHOIR

Normal

Pad

PAD

PAD

Normal

Synthesizer

SYN

SYNTH

Normal

Brass

BRS

BRASS

Normal

Guitar/Bass

G/B

GUITAR/BASS

Normal

Others

OTH

OTHERS

Normal and Drum
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Performances
A group of Voices is referred to as a Performance, and both the CP4 STAGE and CP40 STAGE come with a
wide range of Performances ready for use.
NOTE A full list of your instrument’s Performances can be found in the Data List (pdf).

Parts within a Performance
As shown in the illustration below, each CP4 STAGE Performance contains three Parts; each CP40 STAGE
Performance, two Parts. A Voice is assigned to each of these Parts in order to configure the Performance. In
addition, the Parts that make up a Performance can be overlaid (layering) or divided into separate regions of
the keyboard (splitting).

CP4 STAGE

CP40 STAGE

Multiple
Performances

Multiple
Performances

One Performance

One Performance

MAIN Part

MAIN Part

Piano

Piano

LAYER Part

SPLIT/LAYER Part

Organ

Bass

SPLIT Part
Bass

Performances and Voices
Voices are linked to Performances — that is to say, when you select a new Performance, the Voices for all
Parts will change. In addition, if you select a Part and change its Voice, that change will be reflected in the
current Performance (see the illustration below for details). Changing Voices in this way is referred to as
Performance editing, and this will be described in more detail on the following page. It is important to bear in
mind that Performance editing mode is activated as soon as one of the Part Voices is changed. In addition, if
you select a different Performance at this time, editing mode for the previous Performance will be cancelled
and you will be able to edit the newly selected one.
Select a new Voice
(with only MAIN Part on)

Select a new Performance

Performance 001

Performance 004

Performance 004

MAIN Part

MAIN Part

MAIN Part

Guitar

Piano

Organ

LAYER Part

LAYER Part

LAYER Part

Organ

Brass

Brass

Performance
editing

SPLIT Part

SPLIT Part

Strings

Bass

SPLIT Part
Bass

Voices change together
with Performances

MAIN Part’s Voice changes

Store the Performance (page 29)
(Illustration shows a typical example for the CP4 STAGE.)
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Design of the CP4 STAGE & CP40 STAGE > Tone Generator

Editing Performances
While the CP4 STAGE and CP40 STAGE come with a wide range of Performances already built-in, you can
also create your own. The process of editing a Performance involves changing its Part’s Voice assignments
and various other parameters. Parameters that affect a specific Part are referred to as Part parameters; those
affecting all Parts are referred to as Common parameters.
NOTE For details on the parameters that can be edited to create Performances, refer to Performance Editing (page 13).

Storing Performances internally
When you are happy with the Performance that you are editing, it must be stored on the instrument if you
intend to use it again at a later date. At this time, you can choose a Performance from the stage piano’s User
Memory (page 12) to overwrite with your edited Performance. Alternatively, you can store without specifying
a different Performance, and this will result in the current Performance being overwritten.
NOTE For details on the procedure for storing Performances, refer to the description of the Store Performance function (page 29). For
details on the procedure for renaming a Performance, refer to the description of the Name screen (page 15) from the
Performance Common Edit area.

Saving Performances externally
Performances stored on the stage piano can also be saved to a USB flash-memory device. You will need to
carry out this procedure if you create more original Performances than can be stored internally or if you wish
to create a backup of your Performances. While Performances can be stored internally on an individual
basis, all Performances from User Memory are saved together to a USB flash-memory device as a single Alltype file. The extension .C7A is used for CP4 STAGE Performances; the extension .C8A, for CP40 STAGE
Performances. In addition, Performances saved as an All-type file to a USB flash-memory device can be
loaded together back into the stage piano. Alternatively, any one of the Performances from the saved file can
be selected and loaded individually.
NOTE For details on the procedure for saving Performances externally, refer to the description of the Save screen (page 32) from the
File area.
NOTE For details on the procedure for loading Performances back into the stage piano, refer to the description of the Load screen
(page 33) from the File area.
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Effect Unit
The effect unit is used to apply a range of different effects to the sounds produced by the tone generator in
order, for example, to add thickness, reverb, or a sense of space. In this way, the effect unit can make your
stage piano sound much more expressive.

Makeup of Effects
The CP4 STAGE and CP40 STAGE feature insertion effects for use with individual Parts, system effects that
can be configured for each Performance, and a master compressor and master EQ that affect all
Performances in the same way. Voices produced by the tone generator are processed by the insertion
effects, the system effects, and the master compressor and master EQ in that order, before being output via
your amplifier and speakers.
CP4 STAGE
Audio signal path

One Performance
Insertion
effects

MAIN Part
Piano

A

System effects

B

Chorus

Insertion
effects

LAYER Part
Organ

A

B

Master
compressor

Master
equalizer

Master
compressor

Master
equalizer

Reverb

SPLIT Part
Bass

The Part sliders can be used to
adjust chorus and reverb send
levels for each Part.

CP40 STAGE
One Performance
MAIN Part
Piano

Insertion
effects

A

System effects

B
Chorus

SPLIT/LAYER Part
Bass

Insertion
effects

A

Reverb

B

The Part sliders can be used to
adjust chorus and reverb send
levels for each Part.
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Insertion effects

System effects

Master compressor and EQ

• Applied to up to two individual Parts in
each Performance.
• Each contains two independent effects,
A and B.
• Configured using the Effect-A and
Effect-B screens (page 21) from the
Performance Part Edit area.

• Applied to individual Performances.
• Configured using the Chorus Effect and
Reverb Effect screens (page 14) from
the Performance Common Edit area.

• Applied to all Performances.
• Master compressor configured using
the MasterComp screen (page 44) from
the Utility area.
• Master EQ configured using the Master
EQ screen (page 46) from the Utility
area.
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Insertion effects
Assigned to individual Parts, insertion effects process the sound of the corresponding Voice. Two are
available for use in a Performance, each containing two independent effects, A and B. Parameters for these
effects can be set on the Effect-A and Effect-B screens (page 21) from the Performance Part Edit area. In
addition, the insertion effects can be conveniently turned on and off using the [A] and [B] PART EFFECT
buttons from the control panel.

System effects
The CP4 STAGE and CP40 STAGE feature chorus and reverb as system effects. Because these operate as
send-type effects, audio signals corresponding to the send levels set for each Part are sent together to the
chorus and reverb units, which each output a single processed audio signal. Parameters for chorus and
reverb can be set on the Chorus Effect and Reverb Effect screens (page 14) from the Performance Common
Edit area. In addition, the system effects can be conveniently turned on and off using the [CHORUS] and
[REVERB] SYSTEM EFFECT buttons from the control panel.
NOTE Send levels for each Part can be adjusted using the Part sliders (page 5).

Master compressor
The master compressor modifies the overall sound of the stage piano, and therefore, the same parameters
apply to all Performances. These parameters can be set on the MasterComp screen (page 44) from the
Utility area. In addition, the master compressor can be conveniently turned on and off using the [MASTER
COMP] button from the control panel.

Master equalizer
The master equalizer adjusts the overall sound of the stage piano just before it is output. On the CP4 STAGE,
the master EQ features five frequency bands; on the CP40 STAGE, it has three. The MASTER EQ sliders
located at the right of the control panel can be used to adjust the gain in each band. Moving a slider away
from you increases the gain in the corresponding frequency band and vice-versa. On both the CP4 STAGE
and the CP40 STAGE, the Low and High bands can be switched between peaking and shelving types.
Master EQ parameters are set on the Master EQ screen (page 46) from the Utility area.

Effect categories, types, and parameters
Details on the categories of effect available on the CP4 STAGE and CP40 STAGE as well as their types and
parameters can be found in the Effect Type List and Effect Parameter List sections of the Data List (pdf). In addition,
these effect categories, types, and parameters are described in detail in the Synthesizer Parameter Manual (pdf).

Preset programs
For each effect type, parameter settings suitable for various different modes of use have been prepared as preset
programs. Instead of configuring effects from scratch, you can save considerable time by selecting the preset
program that best matches the current Voices or style of music and then tweaking to suit your specific needs. Preset
programs can be selected using Preset from effect-parameter editing screens. A full list of presets for each effect
type can be found in the Data List (pdf).
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Memory
In addition to original Performances, you can configure a wide range of other parameters on your stage
piano. The methods used to organize this important data and the memory areas where it is stored are
described below.

Internal Memory
Internal data transfer
Exchange of data with other devices

Memory
Bulk Dump

Recall buffer
Compare buffer

MIDI device or computer
(DAW application)

Utility Edit buffer
• Utility setting

User Memory
• Performances
• Utility area settings

Load and save data
(using the File area)

Edit buffer
• Performance editing

Store data (using the
[STORE] button)

Bulk Dump

USB flash-memory
device
All-type file (containing all data from User
Memory)
File extension: .C7A (for CP4 STAGE) or
.C8A (for CP40 STAGE)

User Memory
User Memory is used to store the Performances that come preset on your stage piano, in addition to Utility
settings, which affect the instrument as a whole. This memory area supports both writing and deleting of
data, and it retains its content when the instrument is turned off.

Edit buffer
The Edit buffer is a work area used to store the Performance that is currently being edited. When the
instrument is turned off, the content of this temporary buffer is lost. In order, therefore, to retain any edits
made to a Performance, it must be stored in User Memory before selecting a different Performance or
turning off the stage piano.

Recall and Compare buffers
The Recall buffer serves as backup memory for the Edit buffer. Edits made to a Performance are normally
lost if not stored before selecting a different Performance; however, the Recall function can be used to
restore the edited Performance to the Edit buffer. Meanwhile, the Compare buffer is used to store the state of
a Performance’s settings prior to their being edited. You can then use the Compare Performance function to
toggle between the edited and unedited versions of the Performance in order to determine which one
sounds better. The content of both the Recall and Compare buffers is lost when the instrument is turned off.
NOTE For more details on the Recall function, refer to the description of the Recall screen (page 26) from the Performance Job area.
NOTE For more details on comparing Performances, refer to the description of the Compare Performance function (page 30).
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Design of the CP4 STAGE & CP40 STAGE

Reference

Performances

Performances

A Performance is made up of a number of Voices — up to three on the CP4 STAGE and two on the
CP40 STAGE. As such, each one can produce rich, dense sounds. If you connect a computer or
another MIDI instrument to your stage piano, you can use its Performances to play received MIDI
data. In addition, you can also edit Performance parameters, creating your own original
Performances based on the stage piano’s presets. The following section will describe the various
parameters that can be used in Performance editing, in addition to the Store Performance and
Compare Performance functions.

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name

Editing Performances

Part Edit Area

Performance editing is carried out in two areas: the Common Edit area is used to edit parameters
that affect all Parts, and the Part Edit area is used to edit parameters for individual Parts.

02: Filter/EG
03: Effect-A
04: Effect-B

Common Edit Area
Procedure

01: Play Mode

05: Controller

1. Press the [EDIT] button.
2. On the Edit menu, use the [u] button to select 01: Common, and then press the [ENTER]
button.
3. Using the [d] and [u] buttons, select the type of parameter you wish to edit (01 to 04), and
then press the [ENTER] button.

06: Receive Switch
Master Keyboard Area
Job Area

4. Make the required changes to parameter settings on the corresponding screen.
01: Recall

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.

02: Copy

The following screenshots illustrate how, for example, to edit chorus effect parameters.

03: Bulk
Store Performance Function

01: Common selected in Step 2:

Compare Performance Function

EDIT
D01:Common

E

File Area
01: Save
02: Load

Press the [ENTER] button.

03: Rename

Parameter type selected in Step 3:

04: Delete

1

EDIT Common
D01:Chorus Effect
2

E

06: Memory Info
Utility Area

3

Press the [ENTER] button.

01: General
02: MIDI

Parameter setting screen from Step 4:
5

Common
Chorus Eff

05: Format

Ctg
CHO

8

Type
G Cho

4

6

03: Controller

Preset E
R Basic D

04: MasterComp

7

06: Panel Lock

9

05: Master EQ

Utility Job Area
01: Factory Set
02: Version

Appendix
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1 EDIT Common

Design of the CP4 STAGE & CP40 STAGE

This shows that you are on the Common Edit menu.

2 More symbol
This symbol indicates that other menu items are available for selection. In this case, the next one
can be displayed by pressing the [d] button.

Reference
Performances
Editing Performances

3 Menu item
The items available for selection from the Common Edit menu are shown here. Select the required
item (01 to 04) using the [d] and [u] buttons, and then press the [ENTER] button to display the
editing screen for the corresponding parameters.

Common Edit Area
01: Chorus Effect

4 Selected screen

02: Reverb Effect

The name of the current screen is shown here.

03: General

5 Parameter

04: Name

The parameters available for editing are shown in the top row of text. The current setting (6) for
each is displayed underneath. In addition, the parameter currently being edited is indicated by the
cursor (R) to its left (7). If necessary, use the [l] and [r] buttons to move the cursor and select a
different parameter to edit.

6 Setting
Parameter settings are shown in the bottom row of text. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to change a setting. Note that the cursor (7) must first be moved to the parameter to be
edited.

Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

7 Cursor (R)
The flashing cursor indicates the parameter currently selected for editing.

Master Keyboard Area
Job Area

8 Edit symbol (E)
This symbol is displayed when the current Performance has been edited but not yet stored. All edits
made to the Performance can be stored using the Store Performance function (page 29).

01: Recall

9 More symbol

03: Bulk

This symbol indicates that the current editing screen is split over multiple panes, one of which is
being shown. In this case, you can move to the next pane by pressing the [d] button.

02: Copy

Store Performance Function
Compare Performance Function
File Area

Common Edit area screens and parameters
01: Chorus Effect

02: Load

Parameter name

Description

Ctg

These parameters can be used to select a category and a type for the
chorus effect.

(Chorus Category)

Type
(Chorus Type)

01: Save

Settings: Refer to the Data List (pdf) for a full list of the categories and types that can
be selected.

NOTE Each effect type is described in detail in the Synthesizer Parameter Manual

03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area

(pdf).
01: General

Preset
(Effect Preset)
Effect parameters

This parameter can be used to select one of the current effect type’s
presets, which configure all parameters to suit a particular need. A full list of
presets for each effect type can be found in the Data List (pdf).
The parameters available for editing will depend on the currently selected
effect type. A full list of parameters for each effect type can be found in the
Data List (pdf).
NOTE Each effect parameter is described in detail in the Synthesizer Parameter
Manual (pdf).

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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02: Reverb Effect

Design of the CP4 STAGE & CP40 STAGE

Parameter name

Description

Type

This parameter can be used to set the type of reverb effect to use.

Reference

(Reverb Type)

Settings: Refer to the Data List (pdf) for a full list of the effect types that can be
selected.

Performances

NOTE Each effect type is described in detail in the Synthesizer Parameter Manual
(pdf).

Effect parameters

The parameters available for editing will depend on the currently selected
effect type. A full list of parameters for each effect type can be found in the
Data List (pdf).
NOTE Each effect parameter is described in detail in the Synthesizer Parameter
Manual (pdf).

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name
Part Edit Area

03: General
The General screen is used to edit parameters that affect all of the Performance’s Parts.
Parameter name

Description

SplitPnt

This parameter can be used to specify the note at which the keyboard will be
split between the Performance’s Parts.

(Split Point)

Settings: C♯-2 to G8

NOTE SplitPnt settings can also be changed by holding down the [SPLIT] button

01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

and pressing the key at which you wish to split the keyboard.
Master Keyboard Area

FS Mode

This parameter can be used to set how the foot switch turns on and off the
function assigned to it.
Settings: momentary and latch
momentary: The function will be on while the foot switch is operated and off while it is
not.

latch: Each time the foot switch is operated, the function will be toggled on or off.

Metronome
Tempo

Job Area
01: Recall
02: Copy
03: Bulk

This parameter can be used to select the playback tempo for the
metronome.

Store Performance Function

Settings: 5 to 300

Compare Performance Function

NOTE If you wish to synchronize the stage piano’s tempo with that of another MIDI
device or DAW application, set Sync from the Utility area’s MIDI screen to
“ext” or “auto”. The tempo will be displayed as “EXT” either when “ext” is
selected or when “auto” is selected and MIDI Clock messages are being
received from an external source. You will not be able to modify the tempo in
such a case.

Beat

This parameter can be used to set a time signature for the metronome.

(Metronome Time
Signature)

Settings: 1/4 to 16/4, 1/8 to 16/8, and 1/16 to 16/16

ClickVol

This parameter can be used to set the volume of metronome clicks.

(Metronome Click
Volume)

Settings: 0 to 127

File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General

04: Name (Performance Name)
The Name screen can be used to set a name for the current Performance. To do so, move the
flashing cursor within the current name using the [l] and [r] buttons, and change the character at
each position using the Data Dial or the [-1/NO] and [+1/YES] buttons. Performance names can
contain up to 10 alphanumeric characters.

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Part Edit Area
Procedure

Design of the CP4 STAGE & CP40 STAGE

1. Turn on the Part you wish to edit using the corresponding button.
2. Hold down the [PART SELECT] button and press the Part button from Step 1 once again to
select the Part for editing.

Reference

3. Press the [EDIT] button.

Performances

4. On the Edit menu, use the [d] and [u] buttons to select 02: Part, and then press the [ENTER]
button.
5. Using the [d] and [u] buttons, select the type of parameter you wish to edit (01 to 06), and
then press the [ENTER] button.
6. Make the required changes to parameter settings on the corresponding screen.

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect

NOTE On the CP40 STAGE, the same Part is selected by pressing either the [LAYER] or [SPLIT] button with the
[PART SELECT] button held down.

03: General

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.

04: Name

The following screenshots illustrate how, for example, to edit parameters on the Play Mode screen.

Part Edit Area
01: Play Mode

02: Part selected in Step 4:

02: Filter/EG

EDIT
W02:Part

E

03: Effect-A
04: Effect-B
05: Controller

Press the [ENTER] button.

06: Receive Switch

Parameter type selected in Step 5:

Master Keyboard Area

1

Job Area

EDIT Part:MAIN
D01:Play Mode
2

E

02: Copy

3

03: Bulk

Press the [ENTER] button.

Store Performance Function

Parameter setting screen from Step 6:
5

Part:MAIN
Play Mode
4

01: Recall

8

Volume
115
6

Pan
R20

Gain E
R100 D
7

9

Compare Performance Function
File Area
01: Save
02: Load
03: Rename

1 EDIT Part: (Current Part)
This shows that you are on the Part Edit menu. The name of the Part selected for editing is shown
after the colon (:).
CP4 STAGE: MAIN, LAYER, or SPLIT
CP40 STAGE: MAIN or SP/LA

2 More symbol

04: Delete
05: Format
06: Memory Info
Utility Area

This symbol indicates that other menu items are available for selection. In this case, the next one
can be displayed by pressing the [d] button.

01: General

3 Menu item

03: Controller

The items available for selection from the Part Edit menu are shown here. Select the required item
(01 to 06) using the [d] and [u] buttons, and then press the [ENTER] button to display the editing
screen for the corresponding parameters.

4 Selected screen
The name of the current screen is shown here.

02: MIDI

04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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5 Parameter

Design of the CP4 STAGE & CP40 STAGE

The parameters available for editing are shown in the top row of text. The current setting (6) for
each is displayed underneath. In addition, the parameter currently being edited is indicated by the
cursor (R) to its left (7). If necessary, use the [l] and [r] buttons to move the cursor and select a
different parameter to edit.

Reference
Performances

6 Setting
Parameter settings are shown in the bottom row of text. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to change a setting. Note that the cursor (7) must first be moved to the parameter to be
edited.

Editing Performances
Common Edit Area
01: Chorus Effect

7 Cursor (R)
The flashing cursor indicates the parameter currently selected for editing.

02: Reverb Effect
03: General

8 Edit symbol (E)
This symbol is displayed when the current Performance has been edited but not yet stored. All edits
made to the Performance can be stored using the Store Performance function (page 29).

04: Name
Part Edit Area

9 More symbol

01: Play Mode

This symbol indicates that the current editing screen is split over multiple panes, one of which is
being shown. In this case, you can move to the next pane by pressing the [d] button.

02: Filter/EG
03: Effect-A
04: Effect-B

Part Edit area screens and parameters

05: Controller
06: Receive Switch

01: Play Mode

Master Keyboard Area

Parameter name

Description

Volume

This parameter can be used to set the volume of the current Part. This
allows you to balance the volumes of the Performances’ Parts with one
another.

Job Area
01: Recall
02: Copy

Settings: 0 to 127

NOTE Volume settings can also be adjusted using the corresponding Part slider with
the Volume function activated.

Pan

This parameter can be used to adjust the stereo panning of the current Part.

03: Bulk
Store Performance Function
Compare Performance Function

Settings: L63 (far left) to C (center) to R63 (far right)
File Area

Gain

ChoSend
(Chorus Send)

This parameter can be used to adjust the volume of the Voice assigned to
the current Part.

01: Save

Settings: 0 to 127

02: Load

This parameter can be used to set how much of the current Part’s output
signal is sent to the Chorus effect. Higher values produce a more intense
chorus sound.

03: Rename

Settings: 0 to 127

NOTE ChoSend settings can also be adjusted using the corresponding Part slider
with the Chorus function activated.

RevSend
(Reverb Send)

This parameter can be used to set how much of the current Part’s output
signal is sent to the Reverb effect. Higher values produce a more
pronounced reverb sound.
Settings: 0 to 127

NOTE RevSend settings can also be adjusted using the corresponding Part slider
with the Reverb function activated.

EffA/BSw
(Effect A/B Part Switch)

This parameter can be used to set whether insertion effects should be
applied to the current Part.
Settings: off and on

NOTE On the CP4 STAGE, this parameter can be set to “on” for up to two Parts.

PartMode

This parameter can be used to set a playing mode for the current Part.
Monophonic (mono) Parts can play only one note at a time; polyphonic (poly)
Parts can play multiple notes at the same time.
Settings: mono and poly

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is

04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version

displayed as “---” in such a case.
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Parameter name

Description

VelDepth

This parameter can be used to select how the velocities with which keys are
played will affect the velocities actually output to the tone generator for the
current Part. As shown in the graph below, the larger the value set, the
greater the degree to which output velocities vary in response to changes in
the playing velocity (i.e., the steeper the slope of the graph). If a value of 0 is
set, the output velocities will be totally unaffected by different playing
velocities, resulting in an response similar to that of an organ, where playing
strength has practically no effect on the sound produced.

(Velocity Sensitivity
Depth)

Reference
Performances
Editing Performances
Common Edit Area
01: Chorus Effect

Settings: 0 to 127
When VelOfst (below) is set to 64:
VelDepth = 127

127

02: Reverb Effect

VelDepth = 64

03: General
04: Name

Velocity actually output
to tone generator

VelDepth = 32

Part Edit Area

0
127
Velocity with which key is played

VelOfst
(Velocity Sensitivity
Offset)

01: Play Mode

VelDepth = 0

02: Filter/EG

This parameter can be used to raise or lower all velocities output to the tone
generator for the current Part. As shown in the graphs, 64 is subtracted from
the value set here and the result is doubled to determine the actual amount
by which the output velocities are adjusted. However, if the resultant output
velocity is less than 0, a value of 0 is used; similarly, if the resultant output
velocity is greater than 127, a value of 127 is used.
Settings: 0 to 127
When VelDepth (above) = 64
and VelOfst = 32

127

127

Velocity actually
output to tone
generator

0

When VelDepth (above) = 64
and VelOfst = 96

127

Velocity with which key is played

0

05: Controller
06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy

Velocity actually
output to tone
generator

64

03: Effect-A
04: Effect-B

03: Bulk
Store Performance Function
64

127

Velocity with which key is played

Compare Performance Function
File Area
01: Save

When VelDepth (above) = 64
and VelOfst = 64

127
Velocity actually
output to tone
generator

02: Load
03: Rename
04: Delete
05: Format
06: Memory Info

0
64
127
Velocity with which key is played

NoteShft
(Note Shift)

This parameter can be used to adjust the pitch of the current Part in
semitone units.

Utility Area
01: General
02: MIDI

Settings: -24 to +0 to +24
03: Controller

Detune

PBRange
(Pitch Bend Range)

This parameter can be used to fine tune the pitch of the current Part in units
of 0.1 Hz.

04: MasterComp

Settings: -12.8Hz to +0.0Hz to +12.7Hz

05: Master EQ

This parameter can be used to set the degree to which the pitch bend wheel
changes the pitch of the current Part in semitone units. If, for example, a
value of “12” is set, it will be possible to bend notes by between -12
semitones (one octave lower) and +12 semitones (one octave higher).

06: Panel Lock

Settings: 0 to 12

Utility Job Area
01: Factory Set
02: Version
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Parameter name

Description

MicroTune

This parameter can be used to select a musical tuning system. In total, your
stage piano can replicate seven different systems. While the equal
temperament tuning system has now become standard for pianos, a wide
number of other systems were developed over the years before it was
adopted, and these systems invariably paved the way for the birth of new
musical styles. By selecting different tuning systems, you can enjoy the
unique harmonics of music from the corresponding periods.

(Microtuning)

Settings: Equal, PureMajor, PureMinor, Pythagorean, Meantone, Werckmeister, and
Kirnberger
Equal (equal temperament)
The range of pitches in each octave is divided equally into twelve parts, with each
half-step evenly spaced in pitch. Today, this is by far the most popular tuning system
for pianos.
Pure Major and Pure Minor
These two tuning systems preserve the pure mathematical intervals of each scale,
especially for triadic chords (comprising the root, third, and fifth). These
characteristics can still be heard today in vocal harmonies — such as choirs and
a cappella singing.
Pythagorean
This scale was devised by the famous Greek philosopher Pythagoras and is created
from a series of perfect fifths, which are collapsed into a single octave. The thirds in
this tuning are slightly unstable, but the fourths and fifths are beautiful and suitable for
some leads.
Meantone
This scale was created as an improvement on the Pythagorean scale by making the
major third interval smoother. It was especially popular from the latter part of the 16th
century to the end of the 18th century, with Handel being one of its most notable users.
Werckmeister and Kirnberger
The Werckmeister and Kirnberger scales improve the meantone and Pythagorean
scales by combining them in different ways. Both are uniquely characterized by the
way in which modulation can change the nuances of musical compositions. Often
used in the eras of Bach and Beethoven, they are still employed today to reproduce
the music of those periods on the harpsichord.

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is
displayed as “---” in such a case.

Root
(Microtuning Root)

Certain tuning systems require a root note to be set, and this parameter can
be used to do so for the current Part.

Design of the CP4 STAGE & CP40 STAGE

Reference
Performances
Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function

Settings: C to B

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is
displayed as “---” in such a case.

Porta
Sw
(Portamento Switch)

(Portamento Time)

02: Load

Settings: off and on

03: Rename

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is

This parameter can be used to set the duration of portamento pitch changes
for the current Part. The larger the setting, the longer it will take for the pitch
to change.
Settings: 0 to 127

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is
displayed as “---” in such a case.

Mode
(Portamento Mode)

01: Save

This parameter can be used to set whether portamento is to be applied to
the current Part.

displayed as “---” in such a case.

Time

File Area

This parameter can be used to set the type of notes to which portamento will
be applied for the current Part.
Settings: finger and full
finger: Portamento will be applied only to notes that are played legato — that is, when
the first key is not released until after playing the second.

04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ

full: Portamento will be applied to all notes.

NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is
displayed as “---” in such a case.

LFOSpeed

06: Panel Lock
Utility Job Area

This parameter can be used to change the speed at which the LFO signal
changes. The larger the setting, the faster the changes.

01: Factory Set

Settings: -64 to +63

02: Version
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Parameter name

Description

LFOPMod

This parameter can be used to set the degree to which the LFO signal
produces periodic pitch changes for the current Part. The larger the setting,
the greater the range of pitch changes.

(LFO Pitch Modulation
Depth)

Settings: -64 to +63

LFODelay

MWPMod
(MW Pitch Modulation
Depth)

MWFMod
(MW Filter Modulation
Depth)

This parameter can be used to set how long it takes after pressing a key for
the current Part’s LFO to start generating a signal. The larger the setting, the
longer it will take for the LFO to have an effect.

(MW Amplitude
Modulation Depth)

(Key Off Sound
Volume)

Common Edit Area

02: Reverb Effect

Settings: 0 to 127

04: Name

This parameter can be used to set the degree to which the modulation
wheel produces periodic changes in the filter cutoff frequency for the
current Part. The larger the setting, the greater the range of cutoff frequency
changes.

This parameter can be used to set the degree to which the modulation
wheel produces periodic volume changes for the current Part. The larger
the setting, the greater the range of volume changes.

This parameter can be used to recreate the sound of dampers pressing
against the strings when you remove your fingers from the keyboard. In
specific terms, the parameter sets the volume of this key off sound.
NOTE This parameter cannot be set for certain Voices, and its setting is displayed
as “---” in such a case.

(Striking Position)

Editing Performances

This parameter can be used to set the degree to which the modulation
wheel produces periodic pitch changes for the current Part. The larger the
setting, the greater the range of pitch changes.

Settings: -16 to +16

StrikPos

Performances

01: Chorus Effect

Settings: 0 to 127

KeyOffVol

Reference

Settings: -64 to +63

Settings: 0 to 127

MWAMod

Design of the CP4 STAGE & CP40 STAGE

This parameter can be used to recreate the effect of changing the position
at which the hammers strike the resonators.

03: General

Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk

Settings: top3, top2, top1, default, rear1, rear2, and rear3

Store Performance Function

NOTE This parameter cannot be set for certain Voices, and its setting is displayed

Compare Performance Function

as “---” in such a case.

File Area

02: Filter/EG (Filter & Envelope Generator)

01: Save
02: Load

Parameter name

Description

Cutoff

This parameter can be used to set the cutoff frequency of the filter used with
the current Part’s Voice.

04: Delete

Settings: -64 to +0 to +63

05: Format

This parameter can be used to set the resonance of the filter used with the
current Part’s Voice.

06: Memory Info

Reso
(Resonance)

03: Rename

Utility Area

Settings: -64 to +0 to +63
01: General

Attack
(Attack Time)

Decay
(Decay Time)

Release

These parameters can be used to define how the current Part’s sound will
change between pressing a key and fading away completely.
Settings: -16 to +0 to +16

NOTE Release cannot be set for Parts with a Drum Voice, and its setting is displayed
as “---” in such a case.

(Release Time)

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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03: Effect-A
04: Effect-B
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Parameter name

Description

Reference

Ctg

These parameters can be used to select a category and a type for Insertion
Effects A and B.

Performances

(Effect Category)

Type
(Effect Type)

Settings: Refer to the Data List (pdf) for a full list of the categories and types that can
be selected.

NOTE Each effect type is described in detail in the Synthesizer Parameter Manual
(pdf).

Preset
(Effect Preset)
Effect parameters

This parameter can be used to select one of the current effect type’s
presets, which configure all parameters to suit a particular need. A full list of
presets for each effect type can be found in the Data List (pdf).
The parameters available for editing will depend on the currently selected
effect type. A full list of parameters for each effect type can be found in the
Data List (pdf).
NOTE Each effect parameter is described in detail in the Synthesizer Parameter
Manual (pdf).

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B

05: Controller
On the Controller screen, you can assign a function to each controller for the current Part. When set
to “off”, the controller will perform only its standard function.

05: Controller
06: Receive Switch

Parameter name

Description

Master Keyboard Area

PB

This parameter can be used to assign control of a parameter from Insertion
Effect A or B to the pitch bend wheel.

Job Area

(Controller Destination:
Pitch Bend Wheel)

01: Recall

Settings: off, EffA(+), EffA(-), EffB(+), and EffB(-)
off: None of the above functions is assigned.

02: Copy

EffA(+) or EffB(+): The more the finger slot in the middle of the wheel is pushed away
from you, the greater the effect on the assigned parameter and vice-versa.

03: Bulk

EffA(-) or EffB(-): The more the finger slot in the middle of the wheel is pulled towards
you, the greater the effect on the assigned parameter and vice-versa.

Store Performance Function
Compare Performance Function

MW
(Controller Destination:
Modulation Wheel)

This parameter can be used to assign control of a parameter from Insertion
Effect A or B to the modulation wheel.
Settings: off, EffA(+), EffA(-), EffB(+), and EffB(-)

File Area
01: Save

off: None of the above functions is assigned.
EffA(+) or EffB(+): The more the finger slot at the front of the wheel is pushed away
from you, the greater the effect on the assigned parameter and vice-versa.
EffA(-) or EffB(-): The more the finger slot at the front of the wheel is pulled towards
you, the greater the effect on the assigned parameter and vice-versa.

FS
(Controller Destination:
Foot Switch)

This parameter can be used to assign on/off control of Insertion Effect A or B
to an FC4A or FC5 Foot Switch (sold separately).
Settings: off, EffA, and EffB
off: Neither of the above functions is assigned.

02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area

EffA: The foot switch will turn Insertion Effect A on and off.
EffB: The foot switch will turn Insertion Effect B on and off.

CP4 STAGE:

FC1
(Controller Destination:
Foot Controller 1)

FC2
(Controller Destination:
Foot Controller 2)
CP40 STAGE:

FC

These parameters can be used to assign control of a parameter from
Insertion Effect A or B or control of the current Voice’s volume to an FC7 Foot
Controller (sold separately).

01: General
02: MIDI
03: Controller

Settings: off, EffA(+), EffA(-), EffB(+), EffB(-), and volume

04: MasterComp

off: None of the above functions is assigned.

05: Master EQ

EffA(+) or EffB(+): The more the controller is operated, the greater the effect on the
assigned parameter.

06: Panel Lock

EffA(-) or EffB(-): The more the controller is operated, the smaller the effect on the
assigned parameter.
volume: The foot controller can be used to adjust the current Voice’s volume.

(Controller Destination:
Foot Controller)

Utility Job Area
01: Factory Set
02: Version
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06: Receive Switch
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On the Receive Switch screen, you can enable (“on”) or disable (“off”) the receipt of Control
Change and other MIDI messages by the current Part.
Reference

Parameter name

Description

Bank

This parameter can be used to specify whether the current Part’s Voice
assignment should be affected by MIDI Bank Select messages.

(Bank Select)

Performances
Editing Performances
Common Edit Area

Pgm
(Program Change)

This parameter can be used to specify whether the current Part’s Voice
assignment should be affected by MIDI Program Change messages.

01: Chorus Effect

This parameter can be used to specify whether the current Part should
respond to MIDI Volume messages (Control No. 7).

02: Reverb Effect

Pan

This parameter can be used to specify whether the current Part should
respond to MIDI Pan messages (Control No. 10).

04: Name

CC

This parameter can be used to specify whether the current Part should
respond to MIDI Control Change messages.

01: Play Mode

NOTE When this parameter is set to “off”, changes cannot be made to parameters

02: Filter/EG

Vol
(Volume)

03: General

Part Edit Area

(Control Change)

controlled by MIDI Control Change messages.

PB
(Pitch Bend Wheel)

MW
(Modulation Wheel)

Sus
(Sustain)

This parameter can be used to specify whether the current Part should
respond to MIDI messages from a pitch bend wheel.

05: Controller

This parameter can be used to specify whether the current Part should
respond to MIDI messages from a modulation wheel.
This parameter can be used to specify whether the current Part should
respond to MIDI Sustain messages (Control No. 64).
NOTE This parameter cannot be set for Parts with a Drum Voice, and its setting is
displayed as “---” in such a case.

FS
(Foot Switch)

03: Effect-A
04: Effect-B

This parameter can be used to specify whether the current Part should
respond to MIDI messages produced by operating the bundled foot switch
connected via the [ASSIGNABLE] FOOT SWITCH jack.

06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function

CP4 STAGE:

FC1
(Foot Controller 1)
CP4 STAGE:

FC2
(Foot Controller 2)
CP40 STAGE:

FC
(Foot Controller)

This parameter can be used to specify whether the current Part should
respond to MIDI messages produced by operating a foot controller (sold
separately) connected via the [1] FOOT CONTROLLER jack.
This parameter can be used to specify whether the current Part should
respond to MIDI messages produced by operating a foot controller (sold
separately) connected via the [2] FOOT CONTROLLER jack.
This parameter can be used to specify whether the current Part should
respond to MIDI messages produced by operating a foot controller (sold
separately) connected via the [FOOT CONTROLLER] jack.

NOTE The MIDI messages produced by operating a foot switch or controller can be set on the Controller
screen (page 43) from the Utility area.

Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Master Keyboard Area

Design of the CP4 STAGE & CP40 STAGE

On the Performance Master Keyboard screen, you can configure your CP4 STAGE or CP40 STAGE
for use as a master keyboard. This allows the keyboard to be split into as many as four different
zones, each of which can be used to control another instrument.

Reference

Procedure

Performances

1. Press the [EDIT] button.
2. On the Edit menu, use the [d] and [u] buttons to select 03: Master Keyboard, and then press
the [ENTER] button.
3. On the Master Keyboard screen’s Common pane, press the [+1/YES] button to set
MasterKbdSw to “on”, and then press the [d] button.

Editing Performances
Common Edit Area
01: Chorus Effect

4. Make the required changes to zone settings on the corresponding panes.
02: Reverb Effect

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.

03: General

The following screenshots illustrate how, for example, to edit parameters for Zone 1.

04: Name
Part Edit Area

03: Master Keyboard selected in Step 2:

01: Play Mode

EDIT
W03:Master Keyboard

E

02: Filter/EG
03: Effect-A
04: Effect-B

Press the [ENTER] button.
05: Controller

MasterKbdSw set to “on” in Step 3:

06: Receive Switch

MasterKbd
Common
1

MasterKbdSw E
R on D

Master Keyboard Area
Job Area
01: Recall

Press the [d] button.

02: Copy

Parameter setting screen from Step 4:

03: Bulk
3

7

Store Performance Function

MasterKbd
Zone1

ZoneSw
R on

Channel E
1 W

Compare Performance Function
File Area

2

5

4

6

01: Save

1 MasterKbd Common

02: Load

This shows that you are on the Master Keyboard screen and that the displayed parameter is
common to all four zones.

03: Rename

2 MasterKbd Zone#
This shows that you are on the Master Keyboard screen and that the displayed parameters affect
only the indicated zone. To jump to the corresponding pane for other zones, hold down the [SHIFT]
button and press the [d] or [u] button.

3 Parameter

04: Delete
05: Format
06: Memory Info
Utility Area

The parameters available for editing are shown in the top row of text. The current setting (4) for
each is displayed underneath. In addition, the parameter currently being edited is indicated by the
cursor (R) to its left (5). If necessary, use the [l] and [r] buttons to move the cursor and select a
different parameter to edit.

01: General

4 Setting

04: MasterComp

Parameter settings are shown in the bottom row of text. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to change a setting. Note that the cursor (5) must first be moved to the parameter to be
edited.

05: Master EQ

5 Cursor (R)
The flashing cursor indicates the parameter currently selected for editing.

02: MIDI
03: Controller

06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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6 More symbol

Design of the CP4 STAGE & CP40 STAGE

This symbol indicates that the current editing screen is split over multiple panes, one of which is
being shown. In this case, you can move to the previous or next pane by pressing the [d] or [u]
button.

7 Edit symbol (E)

Reference
Performances

This symbol is displayed when the current Performance has been edited but not yet stored. All edits
made to the Performance can be stored using the Store Performance function (page 29).

Editing Performances
Common Edit Area
01: Chorus Effect

Zone parameters
NOTE With the exception of MasterKbdSw, each of the parameters in the following table can be set
individually for Zones 1 to 4 on the corresponding pane.

Parameter name

Description

MasterKbdSw

This parameter can be used to enable (“on”) or disable (“off”) your CP4
STAGE or CP40 STAGE as a master keyboard. As indicated by Common at
the left of the screen, the MasterKbdSw setting applies to all four zones.

02: Reverb Effect
03: General
04: Name
Part Edit Area

(Master Keyboard
Switch)

Settings: off and on

ZoneSw
(Zone Switch)

Channel

This parameter can be used to enable (“on”) or disable (“off”) the currently
selected zone.

01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B

Settings: off and on

05: Controller

This parameter can be used to set a MIDI send channel for the currently
selected zone.

06: Receive Switch
Master Keyboard Area

Settings: 1 to 16
Job Area

Octave
(Transpose Octave)

Trnsps
(Transpose Semitone)

NoteLimit
Low
(Low Note Limit)

High
(High Note Limit)

BankMSB
(MIDI Bank MSB)

This parameter can be used to shift the pitch of the currently selected zone
upward or downward in units of one octave.

01: Recall

Settings: -3 to +0 to +3

02: Copy

This parameter can be used to shift the pitch of the currently selected zone
upward or downward in units of one semitone.

03: Bulk

Settings: -11 to +0 to +11

Store Performance Function

These parameters can be used to define keyboard sections for each zone.
Low Note Limit defines the lowest key in the currently selected zone; High
Note Limit defines the highest. All keys within this range will produce a note
for the currently selected zone. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to change the settings for these parameters. You can also press a
key while holding down the [SHIFT] button to set it directly.

Compare Performance Function

(MIDI Bank LSB)

PgmNo
(MIDI Program Change
Number)

(MIDI Volume)

02: Load
03: Rename

This parameter can be used to set the Bank Select MSB to be sent as a
MIDI message from the currently selected zone to the corresponding
external instrument upon selection of the Performance. Use the [-1/NO] and
[+1/YES] buttons or the Data Dial to change the setting.

04: Delete

This parameter can be used to set the Bank Select LSB to be sent as a MIDI
message from the currently selected zone to the corresponding external
instrument upon selection of the Performance. Use the [-1/NO] and
[+1/YES] buttons or the Data Dial to change the setting.

05: Format
06: Memory Info
Utility Area
01: General
02: MIDI

Settings: 000 to 127

03: Controller

This parameter can be used to set the Program Change Number to be sent
as a MIDI message from the currently selected zone to the corresponding
external instrument upon selection of the Performance. Use the [-1/NO] and
[+1/YES] buttons or the Data Dial to change the setting.

04: MasterComp

Settings: 1 to 128

Volume

01: Save

Settings: C-2 to G8

Settings: 000 to 127

BankLSB

File Area

This parameter can be used to set the volume of the external instrument
corresponding to the currently selected zone upon selection of the
Performance.
Settings: 0 to 127

05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Parameter name

Description

Pan

This parameter can be used to set the stereo panning of the external
instrument corresponding to the currently selected zone upon selection of
the Performance.

(MIDI Pan)

Settings: L64 to C to R63

TxSw
Bank
(Transmit Bank
Select)

Pgm
(Transmit Program
Change)

Vol
(Transmit Volume)

Pan
(Transmit Pan)

PB
(Transmit Pitch Bend
Wheel)

MW
(Transmit Modulation
Wheel)

SLIDER
(Transmit Slider)

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Bank Select messages from the currently selected zone to the
corresponding external instrument.

Design of the CP4 STAGE & CP40 STAGE

Reference
Performances
Editing Performances
Common Edit Area

Settings: off and on

01: Chorus Effect

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Program Change messages to the external instrument corresponding
to the currently selected zone.

02: Reverb Effect

Settings: off and on

04: Name

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Volume messages to the external instrument corresponding to the
currently selected zone.

03: General

Part Edit Area
01: Play Mode

Settings: off and on

02: Filter/EG

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Pan messages to the external instrument corresponding to the
currently selected zone.

03: Effect-A
04: Effect-B

Settings: off and on

05: Controller

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Pitch Bend messages to the external instrument corresponding to the
currently selected zone.

06: Receive Switch
Master Keyboard Area

Settings: off and on

Job Area

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Modulation messages to the external instrument corresponding to the
currently selected zone.

01: Recall

Settings: off and on

03: Bulk

This parameter can be used to set the Part slider from which MIDI
messages should be sent to the external instrument corresponding to the
currently selected zone. If set to “off”, no MIDI messages will be sent from
the Part sliders.

02: Copy

Store Performance Function
Compare Performance Function
File Area

Settings:

Sus
(Transmit Sustain)

CP4 STAGE: off, MAIN, LAYER, and SPLIT

01: Save

CP40 STAGE: off, MAIN, and SP/LA

02: Load

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Sustain messages to the external instrument corresponding to the
currently selected zone.

03: Rename

Settings: off and on

FS
(Transmit Foot
Switch)

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI messages from the foot switch to the external instrument
corresponding to the currently selected zone.
Settings: off and on

CP4 STAGE:

FC1
(Transmit Foot
Controller 1)

CP4 STAGE:

FC2
(Transmit Foot
Controller 2)

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI messages from Foot Controller 1 to the external instrument
corresponding to the currently selected zone.
Settings: off and on

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI messages from Foot Controller 2 to the external instrument
corresponding to the currently selected zone.

04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock

Settings: off and on
Utility Job Area

CP40 STAGE:

FC
(Foot Controller)

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI messages from the foot controller to the external instrument
corresponding to the currently selected zone.

01: Factory Set
02: Version

Settings: off and on
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Job Area

Design of the CP4 STAGE & CP40 STAGE

As described below, the Performance Job menu provides access to a number of functions that can
prove highly useful when creating your own original Performances.
Reference

Performance Job functions

Performances

From this menu, you can select the Recall, Copy, and Bulk Dump functions.

Editing Performances

01: Recall

Common Edit Area

If, while editing a Performance you have not yet stored, you select a different Performance and then
return to the one being edited, the latest stored version will be selected. Using the Recall function,
however, you can restore all of your edits.
NOTE The Recall buffer (page 12) is used to store the current condition of the Performance being edited. The
content of this buffer is lost when the stage piano is turned off. Accordingly, you will not be able to
restore edits using this function after turning the instrument off and back on.
Procedure

01: Chorus Effect
02: Reverb Effect
03: General
04: Name
Part Edit Area

1. Press the [EDIT] button.
2. On the Edit menu, use the [d] button to select 04: Job, and then press the [ENTER] button.

01: Play Mode

3. Use the [u] button to select 01: Recall, and then press the [ENTER] button.
4. When the Confirmation popup is displayed, press the [+1/YES] button to recall your edits.

02: Filter/EG

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.

03: Effect-A
04: Effect-B

NOTE Before executing Performance Job functions, the instrument will display the Confirmation popup to
confirm that you wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the
function or the [-1/NO] button to return to the previous screen without doing so.

05: Controller
06: Receive Switch
Master Keyboard Area

04: Job selected in Step 2:

EDIT
U04:Job

E

Job Area
01: Recall
02: Copy

Press the [ENTER] button.

03: Bulk

01: Recall selected in Step 3:

Store Performance Function

1

Compare Performance Function

EDIT Job
D01:Recall
2

E

File Area
01: Save

3

02: Load

Press the [ENTER] button.
03: Rename

Confirmation popup from Step 4:
4

Are you sure?
[NO]/[YES]

04: Delete
05: Format
06: Memory Info
Utility Area

1 EDIT Job
This shows that you are on the Performance Job menu.

01: General
02: MIDI

2 More symbol

03: Controller

This symbol indicates that other menu items are available for selection. In this case, the next one
can be displayed by pressing the [d] button.

04: MasterComp

3 Menu item
The items available for selection from the Performance Job menu are shown here. In this case, use
the [u] button to select 01: Recall, and then press the [ENTER] button.

05: Master EQ
06: Panel Lock
Utility Job Area

4 Are you sure?

01: Factory Set

This message is displayed before executing Performance Job functions. Press the [+1/YES] button
to recall your edits. Alternatively, press the [-1/NO] button to return to the previous screen.

02: Version
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02: Copy

Design of the CP4 STAGE & CP40 STAGE

Using the Copy function, you can copy Common and Part parameter settings into the Performance
currently being edited from another Performance. Reusing settings from other Performances in this
way can prove very convenient when creating your own Performances.

Reference

Procedure

Performances

1. Press the [EDIT] button.
2. On the Edit menu, use the [d] button to select 04: Job, and then press the [ENTER] button.
3. Use the [d] and [u] buttons to select 02: Copy, and then press the [ENTER] button.
4. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to select the Performance from which to
copy settings, and then press the [ENTER] button.
5. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to select the settings to be copied and
where to copy them to, and then press the [ENTER] button.
6. When the Confirmation popup is displayed, press the [+1/YES] button to copy the settings.

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name

NOTE Before executing Performance Job functions, the instrument will display the Confirmation popup to
confirm that you wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the
function or the [-1/NO] button to return to the previous screen without doing so.

The following screenshots illustrate how, for example, all settings from the Split Part in Performance
001 can be copied to the Layer Part in the Performance currently being edited.
04: Job selected in Step 2:

Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller

EDIT
U04:Job

E

06: Receive Switch
Master Keyboard Area
Job Area

Press the [ENTER] button.
01: Recall

02: Copy selected in Step 3:
02: Copy

1

03: Bulk

EDIT Job
W02:Copy

E

Store Performance Function
Compare Performance Function

2

3

File Area

Press the [ENTER] button.

01: Save

Performance from which to copy selected in Step 4:

02: Load

Job
Copy

Copy from
E
R001(A01):CFX Grand

03: Rename
04: Delete

4

5

05: Format

Press the [ENTER] button.

06: Memory Info

Settings to copy and their destination selected in Step 5:
9

Job
Copy

Src
RPart:SPLIT 7

6

Dst E
Part:LAYER
8

Utility Area
01: General
02: MIDI
03: Controller

Press the [ENTER] button.
04: MasterComp

Confirmation popup from Step 6:
)

Are you sure?
[NO]/[YES]

05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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1 EDIT Job

Design of the CP4 STAGE & CP40 STAGE

This shows that you are on the Performance Job menu.

2 More symbol
This symbol indicates that other menu items are available for selection. In this case, they can be
displayed using the [d] and [u] buttons.

3 Menu item
The items available for selection from the Performance Job menu are shown here. In this case, use
the [d] or [u] button to select 02: Copy, and then press the [ENTER] button to open the Copy
screen.

Reference
Performances
Editing Performances
Common Edit Area
01: Chorus Effect

4 Selected screen

02: Reverb Effect

The name of the current screen is shown here.

03: General

5 Copy from

04: Name

This shows the Performance from which settings will be copied. Use the [-1/NO] and [+1/YES]
buttons or the Data Dial to select a Performance, and then press the [ENTER] button.

Part Edit Area
01: Play Mode

6 Cursor (R)
The flashing cursor indicates the parameter currently selected for editing.

7 Src (source settings)
This shows the settings that will be copied. If necessary, move the flashing cursor (R) to the setting
underneath Src using the [l] button. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to
select settings to copy from the following.

02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

CP4 STAGE: Common, Part:MAIN, Part:LAYER, Part:SPLIT, and MasterKbd
CP40 STAGE: Common, Part:MAIN, Part:SP/LA, and MasterKbd

Master Keyboard Area

NOTE If Src is set to “MasterKbd”, zone settings will be copied.

Job Area

8 Dst (destination)
This shows the settings from the current Performance that will be overwritten. Move the flashing
cursor (R) to the setting underneath Dst using the [r] button, and then use the [-1/NO] and
[+1/YES] buttons or the Data Dial to select the settings to be overwritten from the following.
CP4 STAGE: Common, Part:MAIN, Part:LAYER, Part:SPLIT, and MasterKbd
CP40 STAGE: Common, Part:MAIN, Part:SP/LA, and MasterKbd
NOTE If Src (source) is set to “Common” or “MasterKbd”, Dst (destination) will be fixed at “Common” or
“MasterKbd”, respectively. If Src (source) is set to a Part, it will not be possible to set Dst (destination) to
“Common” or “MasterKbd”.

01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save

9 Edit symbol (E)

02: Load

This symbol is displayed when the current Performance has been edited but not yet stored.

03: Rename

) Are you sure?

04: Delete

This message is displayed before executing Performance Job functions. Press the [+1/YES] button
to copy the selected settings. Alternatively, press the [-1/NO] button to return to the previous
screen.

05: Format
06: Memory Info
Utility Area

03: Bulk

01: General

Using the Bulk Dump function, you can send all of the data from the currently selected Performance
to a computer or another MIDI instrument.

02: MIDI

Procedure

1. Press the [EDIT] button.

03: Controller

2. On the Edit menu, use the [d] button to select 04: Job, and then press the [ENTER] button.

04: MasterComp

3. Use the [d] button to select 03: Bulk, and then press the [ENTER] button.

05: Master EQ

4. When the Confirmation popup is displayed, press the [+1/YES] button to send the data.
06: Panel Lock

NOTE The Edit menu is the first screen displayed when the [EDIT] button is pressed.
NOTE Before executing Performance Job functions, the instrument will display the Confirmation popup to
confirm that you wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the
function or the [-1/NO] button to return to the previous screen without doing so.
NOTE It will not be possible to send data using the Bulk Dump function if the DevNo parameter (device
number) is set to “off”. This parameter can be set on the MIDI screen (page 42) from the Utility area.

Utility Job Area
01: Factory Set
02: Version
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Store Performance Function

Design of the CP4 STAGE & CP40 STAGE

Using the Store Performance function, you can store the Performance currently being edited in your
stage piano’s User Memory (page 12). The Performance selected at this time will be overwritten
with the edited Performance’s settings.

Reference

Procedure

Performances
Editing Performances

1. Press the [STORE] button while editing a Performance.
2. On the Store screen, use the [-1/NO] and [+1/YES] buttons or the Data Dial to select the
destination for storing the current Performance, and then press the [ENTER] button.
3. When the Confirmation popup is displayed, press the [+1/YES] button to store the
Performance.

Common Edit Area
01: Chorus Effect
02: Reverb Effect

NOTE Performances cannot be stored while audio data is playing.

03: General

NOTE The Store screen is the first screen displayed when the [STORE] button is pressed.
NOTE Before executing the Store Performance function, the instrument will display the Confirmation popup to
confirm that you wish to proceed (“Are you sure?”). You can press the [+1/YES] button to store the
current Performance or the [-1/NO] button to return to the previous screen without doing so.

Destination for storing as selected in Step 2:

Part Edit Area
01: Play Mode
02: Filter/EG

1

STORE

04: Name

R001(A01):CFX Grand

E

2

Press the [ENTER] button.

Confirmation popup from Step 3:
3

03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area
Job Area
01: Recall

Are you sure?
[NO]/[YES]

02: Copy
03: Bulk

1 STORE
This shows that you are on the Store screen.

2 Destination Performance
This entry shows the destination for storing the Performance currently being edited. Use the [-1/NO]
and [+1/YES] buttons or the Data Dial to select a Performance, and then press the [ENTER] button.

Store Performance Function
Compare Performance Function
File Area
01: Save

3 Are you sure?

02: Load

This message is displayed before executing the Store Performance function. Press the [+1/YES]
button to store all of the settings from the Performance currently being edited. When the data has
been stored, the destination Performance will be selected and displayed. To cancel execution of
the Store Performance function and return to the previous screen, press the [-1/NO] button.

03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Compare Performance Function
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Using the Compare Performance function, you can compare the Performance currently being
edited with its unedited version. An area of memory known as the Compare buffer (page 12) is used
to maintain a copy of the unedited version of the current Performance. As described below, this
allows you to toggle between the edited and unedited versions of the Performance in order to
determine which one sounds better.
NOTE The content of the Compare buffer is lost when the instrument is turned off.
Procedure

Performances
Editing Performances
Common Edit Area

Press the [EDIT] button while editing a Performance.

01: Chorus Effect

The following screenshots illustrate how, for example, the Compare Performance function can be
used when editing Part parameters on the Play Mode screen from the Performance Part Edit area.

02: Reverb Effect
03: General
04: Name

Editing parameters:
1

Part:MAIN
Play Mode

Reference

Volume
100

Pan
R C

Gain E
100 D

Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B

Press the [ENTER] button.

05: Controller

Unedited version of Performance in Compare mode:
2

Part:MAIN
Play Mode

Volume
115

Pan
RR20

Gain C
100 D

06: Receive Switch
Master Keyboard Area
Job Area
01: Recall

1 Edit symbol (E)

02: Copy

This symbol is displayed when the current Performance has been edited but not yet stored.
03: Bulk

2 Compare symbol (C)
This symbol is displayed when Compare mode is active. At this time, the parameters will show their
unedited settings. In addition, the [EDIT] button will flash while comparing, and it can be pressed
once again to cancel this mode and return to the edited version of the Performance.
NOTE It is not possible to select a different Performance or to edit Performance parameters while in Compare
mode (i.e., while the Compare symbol is displayed at the top-right of the screen).

Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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File Area

Design of the CP4 STAGE & CP40 STAGE

In the File area, you can save Performances created using your stage piano on a USB flashmemory device, and read data from this type of device. To return to the Performance screen from
the File area, press the [EXIT] button.

Reference
Performances
Editing Performances

File-related terms

Common Edit Area

A number of terms will be used in the following descriptions of File area functions and operations.
Please take a moment to familiarize yourself with their meanings in order that these functions and
operations can be more easily understood.

01: Chorus Effect

File

03: General

The term “file” is used to define a collection of data stored on a memory medium. Data saved to a
USB flash-memory device by your stage piano or a computer takes the form of files, and this format
is also used when reading data back from a USB flash-memory device. A file is identified by a file
name and an extension, as described below.

File name
On the CP4 STAGE and CP40 STAGE, files can be assigned a name containing up to eight
alphanumeric characters and symbols. These names are used to tell files apart, and for this reason,
no two files within a specific directory can share the same file name. Computers are capable of
handling very long file names that can even include non-English characters, but on your
CP4 STAGE or CP40 STAGE, non-English characters will be replaced with symbols and long names
will be truncated to six or seven characters.

02: Reverb Effect

04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area

Extension
The three letters following the period at the end of a file name — such as “.mid” and “.wav” — are
referred to as a file extension. The type of data contained within a file is identified by its extension,
and it is not possible to specify or change an extension using the CP4 STAGE or CP40 STAGE.

File size
The amount of memory needed to store a file is indicated by the file size. These sizes as well as the
capacities of memory devices are presented in standard computer format using B (bytes), KB (kilo
bytes), MB (mega bytes), and GB (giga bytes). (1 KB is equivalent to 1,024 bytes; 1 MB is
equivalent to 1,024 KB; and 1 GB is equivalent to 1,024 MB.)

Directory
A hierarchical system of directories is used on USB flash-memory devices in order to group files
together according to type or application. In this regard, directories are equivalent to the folders
used on a computer. As with files, you can assign names to individual directories, but directories do
not have extensions.

Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete

Root directory

05: Format

The directory initially displayed when you open a USB flash-memory device on a computer or the
like is referred to as the root directory.

06: Memory Info
Utility Area

Mounted
A USB flash-memory device is said to be mounted when it has been connected to the instrument,
the instrument has identified it, and it is ready for use. Your CP4 STAGE or CP40 STAGE will
automatically mount a USB flash-memory device whenever plugged into the [TO DEVICE] USB
terminal. Incidentally, a device that is no longer mounted is said to be unmounted.

Formatting
The operation of initializing a USB flash-memory device is referred to as formatting. Whenever you
format such a device, all of its files and directories (or folders) will be erased.

Save and load
The term “save” refers to the writing of data to a USB flash-memory device for storage, while “load”
refers to the reading of files from this type of device into the instrument’s internal memory. In
contrast, the term “store” is used to refer to writing of data to the internal memory.

01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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File functions

Design of the CP4 STAGE & CP40 STAGE

A total of six different functions can be executed from the File area — Save, Load, Rename, Delete,
Format, and Memory Info.
NOTE The functions from the File area can be used only with All-type files, which have a .C7A (CP4 STAGE) or
.C8A (CP40 STAGE) file extension. They cannot be used to process audio files, which have a .wav file
extension.

Reference
Performances
Editing Performances

01: Save
The Save function is used to store all data from the instrument’s User Memory in the form of an Alltype file. This file must be saved to the USB flash-memory device’s root directory, and it will be
given a .C7A (CP4 STAGE) or .C8A (CP40 STAGE) file extension.
NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Save screen.

Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name

Procedure

1. Press the [FILE] button.
2. On the File menu, press the [u] button to select 01: Save, and then press the [ENTER] button.

Part Edit Area

3. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to enter a file name, and then press the
[ENTER] button.

01: Play Mode

4. When the Confirmation popup is displayed, press the [+1/YES] button to save the data.

02: Filter/EG

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.

03: Effect-A
04: Effect-B

NOTE Before executing File functions, the instrument will display the Confirmation popup to confirm that you
wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the File function or the
[-1/NO] button to return to the previous screen without doing so.

05: Controller
06: Receive Switch
Master Keyboard Area

01: Save selected in Step 2:

Job Area

FILE
D01:Save

01: Recall
02: Copy

Press the [ENTER] button.

File name entered in Step 3:

03: Bulk
Store Performance Function

FILE
Save

Name
[STAGE̲01]

1

2

Compare Performance Function
File Area
01: Save

Press the [ENTER] button.
02: Load

Confirmation popup from Step 4:
3

Are you sure?
[NO]/[YES]

03: Rename
04: Delete
05: Format
06: Memory Info

1 FILE Save
This shows that you are on the File area’s Save screen.

Utility Area
01: General

2 Name
This parameter is used to enter a name (between the square brackets) for the file to be saved to the
USB flash-memory device. Move the flashing cursor within the name field using the [l] and [r]
buttons, and change the character at each position using the [-1/NO] and [+1/YES] buttons or the
Data Dial. Files can be named using alphanumeric characters and symbols, and they can be up to
eight characters long.

3 Are you sure?
This message is displayed before executing the Save function. Press the [+1/YES] button to save
your data. Alternatively, press the [-1/NO] button to return to the previous screen. To cancel saving,
press the [EXIT] button while the “Now saving...” message is displayed.
NOTE If a file with the same name as the one entered on the Save screen already exists on the USB flashmemory device, the instrument will display the message “Overwrite?” to confirm whether that file should
be overwritten.

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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02: Load

Design of the CP4 STAGE & CP40 STAGE

The Load function is used to read a file from a USB flash-memory device into the instrument.
NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Load screen.
NOTE The Load function can only be used to read All-type files located in the USB flash-memory device’s root
directory. If no such file exists in the root directory, the instrument will display the message “File not
found” instead of the Load screen.

Reference
Performances
Editing Performances
Common Edit Area

Procedure

1. Press the [FILE] button.
2. On the File menu, use the [d] and [u] buttons to select 02: Load, and then press the
[ENTER] button.

01: Chorus Effect
02: Reverb Effect

3. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to select a file and load type, and then
press the [ENTER] button.

03: General

4. Carry out the steps for the selected load type as described below.

04: Name

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.
NOTE As shown in the following table, the load type indicates which data from the selected file is to be read
into the instrument.

Part Edit Area
01: Play Mode
02: Filter/EG

Load types
Format

Description

All

All data will be loaded from the selected All-type file (.C7A (CP4 STAGE) or
.C8A (CP40 STAGE) file extension).

All without Sys

All data other than Utility settings will be loaded from the selected All-type
file (.C7A (CP4 STAGE) or .C8A (CP40 STAGE) file extension).

03: Effect-A
04: Effect-B
05: Controller

(All without System)

Performance

One specific Performance will be loaded from the selected All-type file
(.C7A (CP4 STAGE) or .C8A (CP40 STAGE) file extension).

06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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“All” or “All without Sys” selected as load type:

Design of the CP4 STAGE & CP40 STAGE

The following screenshots illustrate how, for example, data can be loaded using the “All” load type.
02: Load selected in Step 2:

Reference

FILE
W02:Load

Performances
Editing Performances
Common Edit Area

Press the [ENTER] button.
01: Chorus Effect

File and load type selected in Step 3:

02: Reverb Effect

FILE
Load

R

Type
All

File
STAGE̲01

1

2

4

3

Press the [ENTER] button.

03: General
04: Name
Part Edit Area
01: Play Mode

Confirmation popup
5

02: Filter/EG

Are you sure?
[NO]/[YES]

03: Effect-A
04: Effect-B
05: Controller

1 Load
This shows that you are on the Load screen.

2 Cursor (R)
The flashing cursor indicates the parameter currently selected for editing.

3 File
This parameter is used to select the file to be loaded. Only All-type files located in the USB flashmemory device’s root directory can be selected here. If necessary, move the flashing cursor (2) to
the setting underneath File using the [r] button. Then, use the [-1/NO] and [+1/YES] buttons or the
Data Dial to select the required file.

06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function

4 Type
This parameter is used to specify a load type — that is, which data from the selected file (3) to load
into the instrument. Move the flashing cursor (2) to the setting underneath Type using the [l]
button, and then use the [-1/NO] and [+1/YES] buttons or the Data Dial to specify the load type.

File Area
01: Save
02: Load

5 Are you sure?
This message is displayed before executing the Load function. Press the [+1/YES] button to load
the selected data. Alternatively, press the [-1/NO] button to return to the previous screen. To cancel
loading, press the [EXIT] button while the “Now loading...” message is displayed.

03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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“Performance” selected as load type:

Design of the CP4 STAGE & CP40 STAGE

The following screenshots illustrate a typical example of Performance loading.
02: Load selected in Step 2:

Reference

FILE
W02:Load

Performances
Editing Performances
Common Edit Area

Press the [ENTER] button.
01: Chorus Effect

File and load type selected in Step 3:

02: Reverb Effect

FILE
Load

R

Type
Performance

File
STAGE̲01

1

2

4

3

Press the [ENTER] button.

04: Name
Part Edit Area
01: Play Mode

Selection of the Performance to be loaded:

FILE
Load

03: General

Src Performance
R001(A01):CFX Grand
5

Press the [ENTER] button.

Selection of a destination for the Performance to be loaded:

02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area

FILE
Load

Dst Performance
R050(A03):71Rd

Job Area
01: Recall

6

Press the [ENTER] button.

Confirmation popup

02: Copy
03: Bulk

7

Store Performance Function

Are you sure?
[NO]/[YES]

Compare Performance Function
File Area

1 to 4

01: Save

See the above descriptions from “All” or “All without Sys” selected as load type.

02: Load

5 Src Performance (source Performance)

03: Rename

This parameter is used to set the Performance to be loaded. Use the [-1/NO] and [+1/YES] buttons
or the Data Dial to select a Performance, and then press the [ENTER] button.

04: Delete
05: Format

6 Dst Performance (destination Performance)
This parameter is used to set a destination for the Performance to be loaded. Use the [-1/NO] and
[+1/YES] buttons or the Data Dial to select a Performance, and then press the [ENTER] button.

7 Are you sure?
This message is displayed before executing the Load function. Press the [+1/YES] button to load
the selected Performance. Alternatively, press the [-1/NO] button to return to the previous screen.
To cancel loading, press the [EXIT] button while the “Now loading...” message is displayed.

06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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03: Rename

Design of the CP4 STAGE & CP40 STAGE

The Rename function is used to rename files that have been saved to a USB flash-memory device.
File names containing non-English characters may not be displayed correctly by the stage piano. In
such a case, this function provides a convenient means of changing these names.

Reference

NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Rename screen.
NOTE The Rename function can only be used to rename All-type files located in the USB flash-memory
device’s root directory. If no such file exists in the root directory, the instrument will display the message
“File not found” instead of the Rename screen.
Procedure

Performances
Editing Performances
Common Edit Area
01: Chorus Effect

1. Press the [FILE] button.

02: Reverb Effect

2. On the File menu, use the [d] and [u] buttons to select 03: Rename, and then press the
[ENTER] button.

03: General

3. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to select the file to be renamed, and
then press the [ENTER] button.
4. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to enter a new file name, and then
press the [ENTER] button.

04: Name
Part Edit Area
01: Play Mode

5. When the Confirmation popup is displayed, press the [+1/YES] button to rename the file.
02: Filter/EG

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.
NOTE Before executing File functions, the instrument will display the Confirmation popup to confirm that you
wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the File function or the
[-1/NO] button to return to the previous screen without doing so.

03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

The following screenshots illustrate a typical example of renaming.
Master Keyboard Area

03: Rename selected in Step 2:

Job Area

FILE
W03:Rename

01: Recall
02: Copy
03: Bulk

Press the [ENTER] button.
Store Performance Function

File for renaming selected in Step 3:

Compare Performance Function

FILE
Rename

File
RSTAGE̲01

1

2

File Area
01: Save
02: Load

Press the [ENTER] button.
03: Rename

File name entered in Step 4:

04: Delete

FILE
Rename

Name
[STAGE̲04]
3

Press the [ENTER] button.

05: Format
06: Memory Info
Utility Area
01: General

Confirmation popup from Step 5:
4

Are you sure?
[NO]/[YES]

02: MIDI
03: Controller
04: MasterComp
05: Master EQ

1 Rename
This shows that you are on the Rename screen.

06: Panel Lock
Utility Job Area

2 File
This parameter is used to select the file to be renamed. Only All-type files located in the USB flashmemory device’s root directory can be selected here. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to select the file you wish to rename, and then press the [ENTER] button.

01: Factory Set
02: Version
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3 Name

Design of the CP4 STAGE & CP40 STAGE

This parameter is used to enter a new name (between the square brackets) for the file. Move the
flashing cursor within the name field using the [l] and [r] buttons, and change the character at
each position using the [-1/NO] and [+1/YES] buttons or the Data Dial. Files can be named using
alphanumeric characters and symbols, and they can be up to eight characters long. When you
have finished entering a name, press the [ENTER] button to proceed.

Reference
Performances
Editing Performances

4 Are you sure?
This message is displayed before executing the Rename function. Press the [+1/YES] button to
rename the file. Alternatively, press the [-1/NO] button to return to the previous screen.

Common Edit Area
01: Chorus Effect
02: Reverb Effect

04: Delete
Using the Delete function, you can remove files from the root directory of a USB flash-memory
device.
NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Delete screen.
NOTE The Delete function can only be used with All-type files located in the USB flash-memory device’s root
directory. If no such file exists in the root directory, the instrument will display the message “File not
found” instead of the Delete screen.
Procedure

1. Press the [FILE] button.
2. On the File menu, use the [d] and [u] buttons to select 04: Delete, and then press the
[ENTER] button.
3. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to select the file to be deleted, and then
press the [ENTER] button.

03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area

4. When the Confirmation popup is displayed, press the [+1/YES] button to delete the file.
Job Area

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.

01: Recall

NOTE Before executing File functions, the instrument will display the Confirmation popup to confirm that you
wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the File function or the
[-1/NO] button to return to the previous screen without doing so.

The following screenshots illustrate a typical example of deleting.

02: Copy
03: Bulk
Store Performance Function
Compare Performance Function

04: Delete selected in Step 2:

File Area

FILE
W04:Delete

01: Save
02: Load

Press the [ENTER] button.

03: Rename

File for deletion selected in Step 3:

04: Delete

FILE
Delete

File
RSTAGE̲01

1

2

Press the [ENTER] button.

Confirmation popup from Step 4:
3

Are you sure?
[NO]/[YES]

05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ

1 Delete
This shows that you are on the Delete screen.

06: Panel Lock
Utility Job Area

2 File
This parameter is used to select the file to be deleted. Only All-type files located in the USB flashmemory device’s root directory can be selected here. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to select the file you wish to delete, and then press the [ENTER] button.

01: Factory Set
02: Version
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3 Are you sure?

Design of the CP4 STAGE & CP40 STAGE

This message is displayed before executing the Delete function. Press the [+1/YES] button to
delete the file. Alternatively, press the [-1/NO] button to return to the previous screen.
Reference

05: Format

Performances

You can use the Format function to initialize a USB flash-memory device. In order to use a new USB
flash-memory device with your stage piano’s other File area functions, it must first be formatted.

Editing Performances
Common Edit Area

NOTICE
When a USB flash-memory device is formatted, all of its content will be deleted. Before executing this
function, therefore, you should ensure that the USB flash-memory device contains no irreplaceable data.

01: Chorus Effect

NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Format screen.

02: Reverb Effect
03: General
04: Name

Procedure

1. Press the [FILE] button.
2. On the File menu, use the [d] and [u] buttons to select 05: Format, and then press the
[ENTER] button.
3. When the Confirmation popup is displayed, press the [+1/YES] button to format the USB flashmemory device.

Part Edit Area
01: Play Mode
02: Filter/EG

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.

03: Effect-A
04: Effect-B

NOTE Before executing File functions, the instrument will display the Confirmation popup to confirm that you
wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the File function or the
[-1/NO] button to return to the previous screen without doing so.

05: Controller
06: Receive Switch
Master Keyboard Area

06: Memory Info

Job Area

Using the Memory Info function, you can confirm how much free space is available on a USB flashmemory device.
NOTE Before carrying out the steps described below, ensure that the USB flash-memory device is plugged
into the instrument’s [TO DEVICE] USB terminal. If this is not the case, the instrument will display the
message “USB device not ready” instead of the Memory Info screen.
Procedure

01: Recall
02: Copy
03: Bulk

1. Press the [FILE] button.

Store Performance Function

2. On the File menu, use the [d] button to select 06: Memory Info, and then press the [ENTER]
button.

Compare Performance Function
File Area

NOTE The File menu is the first screen displayed when the [FILE] button is pressed.

01: Save

The following screenshots illustrate a typical example of using the Memory Info function.

02: Load
03: Rename

06: Memory Info selected in Step 2:

04: Delete

FILE
U06:Memory Info

05: Format
06: Memory Info

Press the [ENTER] button.

Utility Area
01: General

Memory information displayed:

FILE
MemoryInfo

Free
1.2GB

Total
1.8GB

1

2

3

1 MemoryInfo
This shows that you are on the Memory Info screen.

2 Free

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area

This shows how much free space is available on the currently mounted USB flash-memory device.

01: Factory Set

3 Total

02: Version

This shows the total memory capacity of the currently mounted USB flash-memory device.
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Utility Area

Design of the CP4 STAGE & CP40 STAGE

The Utility area is used to make settings that affect the entire instrument.
Reference

Procedure

1. Press the [UTILITY] button.
2. On the Utility menu, use the [d] and [u] buttons to select the type of parameter you wish to
set (01 to 06), and then press the [ENTER] button.
3. Make the required changes to parameter settings on the corresponding screen.

Performances
Editing Performances
Common Edit Area

NOTE The Utility menu is the first screen displayed when the [UTILITY] button is pressed.

01: Chorus Effect

NOTE For details concerning 07: Job, refer to the description of the Utility Job area (page 48).

02: Reverb Effect

The following screenshots illustrate how, for example, to set parameters from the General screen.

03: General
04: Name

Parameter type selected in Step 2:

Part Edit Area

1

UTILITY
D01:General

E

02: Filter/EG
03: Effect-A
04: Effect-B

2

Press the [ENTER] button.

05: Controller

Parameter setting screen from Step 3:
8

4

UTILITY
General

01: Play Mode

+

MasterTune
0.0/440.0Hz

3

Trnsps E
R+ 0 D

5

6

7

1 UTILITY
This shows that you are on the Utility menu.

06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk

2 Menu item

Store Performance Function

The items available for selection from the Utility menu are shown here. Select the required item (01
to 06) using the [d] and [u] buttons, and then press the [ENTER] button to display the setting
screen for the corresponding parameters.

Compare Performance Function

3 Selected screen

File Area
01: Save

The name of the current screen is shown here.

02: Load

4 Parameter

03: Rename

The parameters available for setting are shown in the top row of text. The current setting (5) for
each is displayed underneath. In addition, the parameter currently being set is indicated by the
cursor (R) to its left (6). If necessary, use the [l] and [r] buttons to move the cursor and select a
different parameter to set.

04: Delete

5 Setting
Parameter settings are shown in the bottom row of text. Use the [-1/NO] and [+1/YES] buttons or the
Data Dial to change a setting. Note that the cursor (6) must first be moved to the parameter to be
set.

05: Format
06: Memory Info
Utility Area
01: General
02: MIDI

6 Cursor (R)

03: Controller

The flashing cursor indicates the parameter currently selected for editing.

04: MasterComp

7 More symbol

05: Master EQ

This symbol indicates that the current Utility area screen is split over multiple panes, one of which is
being shown. In this case, you can move to the next pane by pressing the [d] button.

06: Panel Lock

8 Edit symbol (E)
This symbol is displayed when the instrument’s settings have been modified but not yet stored.
Press the [STORE] button to store the modified settings.

Utility Job Area
01: Factory Set
02: Version
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01: General

Design of the CP4 STAGE & CP40 STAGE

The General screen is primarily used to configure the instrument’s tone generator.
Parameter name

Description

Reference

MasterTune

This parameter can be used to adjust the tuning of all sounds produced by
the tone generator in units of one cent.

Performances

(Master Tuning)

Settings: -102.4 (414.7Hz) to +0.0 (440.0Hz) to +102.3 (466.8Hz)

NOTE The stage piano’s default tuning is 440 Hz (for A3), and 3 to 4 cents is roughly

Editing Performances
Common Edit Area

equivalent to 1 Hz.
01: Chorus Effect

Trnsps
(Master Transpose)

This parameter can be used to adjust the pitch of the keyboard in steps of
one semitone.

02: Reverb Effect

Settings: -12 to +0 to +12

03: General

NOTE If the current settings require the instrument to play a note outside the range
of frequencies it can reproduce, a note one octave higher or lower will be
played instead.

NOTE The Trnsps setting can also be adjusted using the [-] and [+] TRANSPOSE
buttons from the control panel.

VelCurve
(Velocity Curve)

This parameter can be used to select a curve for determining how the actual
velocities will be generated according to the strength with which you play
notes on the keyboard.
Settings: normal, narrow, wide1, wide2, and fixed

02: Filter/EG
03: Effect-A
04: Effect-B

narrow: The Soft curve makes it easier to produce high velocities across the entire
keyboard.

06: Receive Switch

fixed: The Fixed curve can be used to send a fixed velocity to the tone generator
regardless of how hard or soft you play the keyboard. The actual velocity to be sent
can be set using the following FixedVel parameter.

The Fixed curve can be used to send this fixed velocity to the tone
generator regardless of how hard or soft you play the keyboard. (This
parameter can be set only when VelCurve has been set to “fixed”.)
Settings: 1 to 127

NOTE When VelCurve is not set to “fixed”, this parameter’s setting is displayed as
“---”.

AudioPlay
Volume

01: Play Mode

05: Controller

wide2: The Wide curve accentuates your playing strength by producing lower
velocities in response to softer playing and louder velocities in response to harder
playing. As such, you can use this setting to expand the dynamic range of your
performances.

(Fixed Velocity)

Part Edit Area

normal: The Normal curve produces velocities in direct proportion to the strength of
your keyboard playing.

wide1: The Hard curve makes it more difficult to produce high velocities across the
entire keyboard.

FixedVel

04: Name

This parameter can be used to adjust the volume at which the instrument will
play audio files from a USB flash-memory device.
Settings: 0 to 127

NOTE Normally, when this parameter is set to “127” for audio files recorded using
the stage piano, they will be played back at the actual recording volume. This
does not apply, however, to audio files that have been normalized or
processed in another similar way.

Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area

This parameter can be used to set the number of precount beats played
before recording starts.

01: General

(Audio Recording
Precount)

Settings: off and 1meas to 8meas

02: MIDI

AutoClk

This parameter can be used to specify whether the metronome should
automatically start to play at the beginning of recording.

04: MasterComp

Settings: off and on

05: Master EQ

AudioRec
PreCount

03: Controller

(Audio Recording
Auto Click)

06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Parameter name

Description

Design of the CP4 STAGE & CP40 STAGE

Display
SliderFnc

This parameter can be used to specify whether or not the Slider Function
screens, which display the parameters (or functions) assigned to the Part
sliders as well as their current values, should be automatically displayed
when the control panel’s [SLIDER FUNCTION] button is pressed.

Reference

(Slider Function
Display Switch)

Settings: off and on

Editing Performances

A slider function screen:

SLIDER
Volume

SPLIT
100

Assigned parameter

Current value

LAYER
80

MAIN
100

(Slider Display Time)

Common Edit Area
01: Chorus Effect
02: Reverb Effect

(Illustration shows a CP4 STAGE screen.)

Time

Performances

This parameter can be used to specify how, when the Part sliders and
MASTER EQ sliders are operated, the corresponding popup screens should
be displayed.
Part sliders: The Time parameter specifies whether or not a popup screen
(see below) showing the current value of the parameter assigned to the
slider in question should be displayed, and if so, how long the instrument
should wait before returning to the previous screen.
MASTER EQ sliders: The Time parameter specifies whether or not a popup
screen (see below) showing the current gain setting for the band in question
should be displayed, and if so, how long the instrument should wait before
returning to the previous screen.
Settings: off, 1sec, 1.5sec, 2sec, 3sec, 4sec, 5sec, and keep

03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

off: Popup screens will not be displayed.
1sec to 5sec: A popup screen will be displayed when a slider is operated and will
automatically disappear 1 to 5 seconds later.
keep: A popup screen will be displayed when a slider is operated and will not
disappear until another button is pressed.

Screen displayed when a Part slider is operated:

Part:MAIN ChoSend
100
(Illustration shows when ChoSend settings are adjusted for the Main Part.)

Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function

Screen displayed when a MASTER EQ slider is operated:

Low LowMid
+ 0dB + 0dB

Mid HighMid High
+ 0dB + 0dB + 0dB
(Illustration shows a CP4 STAGE screen.)

AutoOff
(Auto Power-Off Time)

File Area
01: Save
02: Load

The Auto Power-Off function turns off the instrument after a certain period of
inactivity, and this parameter can be used to set the length of that period.
The default setting for this parameter is “30min”.

03: Rename

Settings: off (i.e., instrument is not turned off automatically), 5min, 10min, 15min,
30min, 60min, and 120min

05: Format

NOTE You can conveniently set the AutoOff parameter to “off” by turning on the

06: Memory Info

instrument with the left-most key held down. In addition, the “off” setting will
be automatically stored at this time.

04: Delete

Utility Area

This parameter can be used to select the Performance to be shown on the
Performance screen, which is displayed immediately after the instrument is
turned on.

01: General

Settings: 001 to 128

03: Controller

Contrast

This parameter can be used to adjust the contrast of the instrument’s LCD.

04: MasterComp

(LCD Contrast)

Settings: 1 to 8

StartUp

NOTE You can also adjust the contrast by pressing the [-1/NO] and [+1/YES]
buttons with the [UTILITY] button held down.

02: MIDI

05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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02: MIDI

Design of the CP4 STAGE & CP40 STAGE

The MIDI screen is used to set the instrument’s MIDI-related parameters.
NOTE Refer to the Appendix section (page 50) for more details regarding MIDI.
Reference

Parameter name

Description

IN/OUT

This parameter can be used to set the interface used for exchanging MIDI
messages.

(MIDI IN/OUT)

Settings: MIDI and USB
MIDI: MIDI messages will be exchanged via the [IN] and [OUT] MIDI terminals.

Performances
Editing Performances
Common Edit Area
01: Chorus Effect

USB: MIDI messages will be exchanged via the [TO HOST] USB terminal.

NOTE It is not possible to exchange MIDI messages with another instrument via the
MIDI and USB interfaces at the same time. Be sure, therefore, to set this
parameter correctly in accordance with your equipment setup.

LocalSw
(Local Switch)

This parameter can be used to turn local control on and off. When “off” is
selected, the stage piano’s tone generator is essentially disconnected from
its controllers, and no sound will be produced in response to playing of the
keyboard. The stage piano does, however, continue to transmit MIDI
messages when LocalSw has been set to “off”, and the tone generator will
continue to produce sound in response to received MIDI messages.
Settings: off (disconnected) and on (connected)

TxRxSw
(Transmit & Receive
Switch)

This parameter can be used to specify whether Bank Select and Program
Change MIDI messages are to be exchanged between the stage piano and
other MIDI devices.
Settings: off, pgm, and bank&pgm

(MIDI Synchronization)

03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch

off: Neither Bank Select nor Program Change MIDI messages will be transmitted and
received.

Master Keyboard Area

pgm (Program Change): Program Change MIDI messages will be transmitted and
received, but Bank Select MIDI messages will not.

Job Area

bank&pgm (Bank Select & Program Change): Both Bank Select and Program
Change MIDI messages will be transmitted and received.

Sync

02: Reverb Effect

This parameter can be used to specify whether metronome playback or
tempo-dependent effect parameters should be controlled based on the
stage piano’s internal clock or on external clock messages received from a
DAW application on a connected computer or from a connected MIDI
device.
Settings: int, ext, and auto
int (internal): Synchronization is based on the internal clock. Use this setting when
your stage piano is to be used alone or as the master clock source for other
equipment.
ext (external): Synchronization is based on clock messages received via MIDI. Use
this setting when an external device is to be used as master.
auto: Clock messages received via MIDI will be prioritized over the stage piano’s
current tempo. If no such messages are received, synchronization will be based on
the internal clock set to the last tempo received via MIDI.

NOTE When this parameter is set to “ext”, you will need to configure your DAW
application or external MIDI device to send MIDI Clock messages to the CP4
STAGE or CP40 STAGE.

01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area

ClockOut
(MIDI Clock Out)

This parameter can be used to enable (“on”) or disable (“off”) the sending of
MIDI Clock messages (i.e., F8 Timing Clock) via the MIDI [OUT] terminal.
Settings: on and off

BasicCh
(Basic Channel)

01: General
02: MIDI

This parameter can be used to set the channel for transmission and
reception of Performance changes.

03: Controller

Settings: 1 to 16 and off

04: MasterComp

NOTE Irrespective of this parameter’s setting, the channels for transmission and

05: Master EQ

reception of Part changes are permanently set to channels 1 to 3 for the CP4
STAGE or channels 1 and 2 for the CP40 STAGE.

06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Parameter name

Description

Design of the CP4 STAGE & CP40 STAGE

DevNo

This parameter can be used to set a MIDI device number for the stage
piano. In order to successfully exchange bulk data, parameter changes, or
other system exclusive messages with another MIDI device, this number
must match the device’s.

Reference

(Device Number)

Settings: 1 to 16, all, and off

NOTE When this parameter is set to “all”, Device Number 1 is used for bulk data sent
from the stage piano.

Performances
Editing Performances
Common Edit Area
01: Chorus Effect

03: Controller

02: Reverb Effect

The Controller screen is used to set controller assignments that affect all of the instrument’s
performances. Controllers connected to the stage piano can be assigned MIDI control change
numbers. This allows you to, for example, change the intensity of an effect or apply modulation
using a controller.
NOTE An external sequencer or MIDI controller can be used to control parameters for which the stage piano
does not have its own external controller.

04: Name
Part Edit Area
01: Play Mode
02: Filter/EG

Parameter name

Description

Sustain

This parameter can be used to specify the type of foot switch connected to
the [SUSTAIN] FOOT SWITCH jack on the rear panel.
If using an FC3A (included): Select “FC3 Half On” when you wish to use the
half-damper playing technique and “FC3 HalfOff” when you do not.
If using an FC4A or FC5 (optional): Select “FC4/5”. (Half-damper playing is
not possible with these foot switches.)

(Foot Switch Sustain
Select)

03: General

03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area

Settings: FC3 Half On, FC3 HalfOff, and FC4/5

NOTE Half-damper playing is also possible using Control Change messages from
another MIDI device. In such a case, there is no need to set the Sustain
parameter.

FS
(Foot Switch Control
Number)

This parameter can be used to set a control change number for MIDI
messages produced by operating the foot switch connected to the
[ASSIGNABLE] FOOT SWITCH jack. When MIDI messages with this control
change number are received from another MIDI device, the stage piano
treats them as if they had been produced by the foot switch.
Settings: off, 01 to 95, 98 (Play/Stop), 99 (PC Inc), and 100 (PC Dec)

NOTE If you set FS to “98 (Play/Stop)” and have an FC4A or FC5 Foot Switch
connected via the [ASSIGNABLE] FOOT SWITCH jack, you will be able to
start and stop playback of audio files from a USB flash-memory device using
the foot switch. Alternatively, you can set FS to “99 (PC Inc)” or
“100 (PC Dec)” to change Performance numbers with the foot switch.

Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load

The following screenshot illustrates a typical setting.

03: Rename

Controller screen:

04: Delete

UTILITY
Controller

Sustain
FS E
FC3 Half OnR 80[General5] D
Controller number [Controller name]
This setting shows the selected control change
number together with the corresponding controller
name in square brackets.

05: Format
06: Memory Info
Utility Area
01: General
02: MIDI

CP4 STAGE:

FC1
(Foot Controller 1
Control Number)

This parameter can be used to specify the control change number for MIDI
messages produced in response to operation of the foot controller
connected via the [1] FOOT CONTROLLER jack. Any MIDI messages
received from an external source with this control change number will also
be treated as if they had been produced by Foot Controller 1.

03: Controller
04: MasterComp
05: Master EQ

Settings: off and 00 to 95

NOTE Settings of “00” and “32” have no effect on the instrument and do not
generate MIDI data.

06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Parameter name

Description

CP4 STAGE:

This parameter can be used to specify the control change number for MIDI
messages produced in response to operation of the foot controller
connected via the [2] FOOT CONTROLLER jack. Any MIDI messages
received from an external source with this control change number will also
be treated as if they had been produced by Foot Controller 2.

FC2
(Foot Controller 2
Control Number)

Settings: off and 00 to 95

NOTE Settings of “00” and “32” have no effect on the instrument and do not

Design of the CP4 STAGE & CP40 STAGE

Reference
Performances
Editing Performances
Common Edit Area

generate MIDI data.
01: Chorus Effect

CP40 STAGE:

FC
(Foot Controller)

This parameter can be used to specify the control change number for MIDI
messages produced in response to operation of the foot controller
connected via the [FOOT CONTROLLER] jack. Any MIDI messages
received from an external source with this control change number will also
be treated as if they had been produced by the foot controller.

02: Reverb Effect
03: General
04: Name

Settings: off and 00 to 95

NOTE Settings of “00” and “32” have no effect on the instrument and do not
generate MIDI data.

Part Edit Area
01: Play Mode
02: Filter/EG

04: MasterComp (Master Compressor)
The Master Compressor screen is used to set the following compressor parameters, which affect all
Performances.
Parameter name

Description

Preset

This parameter can be used to select one of the master-compressor
presets, which configure all parameters to suit a particular need.

03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area
Job Area

Settings: Basic, Maximizer, Wild, Attacky, Hard, Hip Club, and Slap Bass(ch)
01: Recall

LowTh
(Low Threshold)

This parameter can be used to set the input-signal level at which the
compressor starts to process the sound in the low-frequency band.
Settings: -54dB to -6dB

LowAtk
(Low Attack)

This parameter can be used to set the amount of time that elapses between
arrival of an input signal and activation of the compressor in the lowfrequency band.
Settings: 1ms to 200ms

LowRat
(Low Ratio)

LowGain
(Low Gain)

(Mid Threshold)

(Mid Attack)

Store Performance Function
Compare Performance Function
File Area
01: Save

Settings: 1.0 to 20.0

02: Load

This parameter can be used to set the output level for the low-frequency
band.

03: Rename

This parameter can be used to set the input-signal level at which the
compressor starts to process the sound in the mid-frequency band.
Settings: -54dB to -6dB

MidAtk

03: Bulk

This parameter can be used to set the compression ratio for the lowfrequency band.

Settings: -∞ to +18dB

MidTh

02: Copy

This parameter can be used to set the amount of time that elapses between
arrival of an input signal and activation of the compressor in the midfrequency band.

04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI

Settings: 1ms to 200ms
03: Controller

MidRat
(Mid Ratio)

MidGain
(Mid Gain)

This parameter can be used to set the compression ratio for the midfrequency band.

04: MasterComp

Settings: 1.0 to 20.0

05: Master EQ

This parameter can be used to set the output level for the mid-frequency
band.

06: Panel Lock

Settings: -∞ to +18dB

Utility Job Area
01: Factory Set
02: Version

Appendix

44

CP4 STAGE/CP40 STAGE Reference Manual

Parameter name

Description

HighTh

This parameter can be used to set the input-signal level at which the
compressor starts to process the sound in the high-frequency band.

(High Threshold)

Design of the CP4 STAGE & CP40 STAGE

Reference

Settings: -54dB to -6dB
Performances

HighAtk
(High Attack)

This parameter can be used to set the amount of time that elapses between
arrival of an input signal and activation of the compressor in the highfrequency band.
Settings: 1ms to 200ms

HighRat
(High Ratio)

This parameter can be used to set the compression ratio for the highfrequency band.
Settings: 1.0 to 20.0

HighGain
(High Gain)

This parameter can be used to set the output level for the high-frequency
band.
Settings: -∞ to +18dB

DivFreqL
(Low Dividing
Frequency)

DivFreqH
(High Dividing
Frequency)

CmnRel
(Common Release)

This parameter can be used to set the frequency that divides the low- and
mid-frequency bands.
Settings: 16Hz to 20kHz

This parameter can be used to set the frequency that divides the mid- and
high-frequency bands.

Editing Performances
Common Edit Area
01: Chorus Effect
02: Reverb Effect
03: General
04: Name
Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B

Settings: 16Hz to 20kHz

05: Controller

Affecting all three compression bands, this parameter can be used to set
the amount of time that elapses until the sound is no longer being
compressed.

06: Receive Switch

Settings: 10ms to 3000ms

Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk
Store Performance Function
Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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05: Master EQ

Design of the CP4 STAGE & CP40 STAGE

The Master EQ screen can be used to adjust the tone of all Performances. The master equalizer on
the CP4 STAGE has five frequency bands (Low, LowMid, Mid, HighMid, and High), while that on the
CP40 STAGE has three (Low, Mid, and High). Using the parameters on this screen, you can
increase or decrease the level of signals in each of these bands.

Performances

Q (Resonance)

Gain

Reference

+

Editing Performances
Common Edit Area

0
Frequency

01: Chorus Effect
02: Reverb Effect

–
03: General
Five frequency bands

Low LowMid

Mid

HighMid High

04: Name

Parameter name

Description

Shape

These parameters can be used to select a shelving type or peaking type
response for each of the equalizer’s Low and High bands. When set to
“shelv”, signals at all frequencies either above (High band) or below (Low
band) the specified frequency will be uniformly boosted or cut. Meanwhile,
when set to “peak”, signals around each band’s center frequency will be
boosted in a localized fashion.

01: Play Mode

Settings: shelv (shelving type) and peak (peaking type)
shelv

05: Controller

EQ Low

Part Edit Area

03: Effect-A
04: Effect-B

06: Receive Switch

EQ High

Gain
Frequency
setting

+

02: Filter/EG

+

Gain
Frequency
setting

0

0

–

–

Master Keyboard Area
Job Area
01: Recall

Frequency

Frequency

02: Copy

peak
+

03: Bulk

Gain
Frequency
setting

Store Performance Function

0

Compare Performance Function

Frequency

File Area

–

Freq
(Frequency)

These parameters can be used to set the center frequency of each band —
that is, the frequency at which the signal will be boosted or cut.

01: Save
02: Load

Settings:
Low band: 32Hz to 2.0kHz for shelving; 63Hz to 2.0kHz for peaking

03: Rename

LowMid, Mid, and HighMid bands: 100Hz to 10kHz

04: Delete

High band: 500Hz to 16kHz

Q
(Resonance)

NOTE LowMid and HighMid settings apply to the CP4 STAGE only.

05: Format

This parameter can be used to set the width of boosting or cutting around
the frequency set using Freq. As such, it can create a range of frequency
characteristic curves. If you set a large value, a narrower band of
frequencies will be boosted or cut, and the tone will change markedly
around the center frequency. If you set a smaller value, a wider band of
frequencies will be boosted or cut, and the tone will change more gradually
around the center frequency.

06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller

Settings: 0.1 to 12.0
+

0

0.1
12.0
Frequency

04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area

–
Frequency setting

NOTE The Q parameter cannot be set for the Low and High bands when their
respective Shape parameters have been set to “shelv”, and its setting is
displayed as “---” in such a case.

01: Factory Set
02: Version
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06: Panel Lock
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Using the [PANEL LOCK] button, you can lock your stage piano’s buttons, Part sliders, and other
controllers in order to avoid operating them by mistake while playing. On the Panel Lock screen,
you can set each of the following parameters to “off” to prevent the [PANEL LOCK] button from
locking the corresponding controllers.
NOTE By default, all controllers except the following can be locked: [PANEL LOCK] button, [SHIFT] button,
[EXIT] button, MASTER EQ sliders, [MASTER VOLUME] dial, keyboard, pitch bend wheel, modulation
wheel, foot switch, and Foot Controllers 1 and 2 (CP4 STAGE) or foot controller (CP40 STAGE).

Reference
Performances
Editing Performances
Common Edit Area

Parameter name

Description

01: Chorus Effect

Part

This parameter can be used to enable (“on”) or disable (“off”) locking of the
Part-related controllers shown below.

02: Reverb Effect

Settings: off and on

03: General

NOTE This setting applies to all of the following controllers; individual settings are

04: Name

(Panel Lock: Parts)

not supported.
Controllers affected: [MAIN], [LAYER], and [SPLIT] buttons; [PART SELECT]
button; [SLIDER FUNCTION] button; and Part sliders

Part Edit Area
01: Play Mode

Audio
(Panel Lock: Audio)

This parameter can be used to enable (“on”) or disable (“off”) locking of the
audio recording and playback controllers shown below.
Settings: off and on

NOTE This setting applies to all of the following controllers; individual settings are
not supported.
Controllers affected: [J] (Stop), [R] (Play), and [I] (Record) buttons

Effect
(Panel Lock: Effects)

This parameter can be used to enable (“on”) or disable (“off”) locking of the
effect-related controllers shown below.
Settings: off and on

NOTE This setting applies to all of the following controllers; individual settings are
not supported.
Controllers affected: [CHORUS] and [REVERB] SYSTEM EFFECT buttons;
[MASTER COMP] button; and [A] and [B] PART EFFECT buttons

Trnsps
(Panel Lock:
Transpose)

VceSel
(Panel Lock: Voice
Select)

This parameter can be used to enable (“on”) or disable (“off”) locking of the
[-] and [+] TRANSPOSE buttons.

02: Filter/EG
03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area
Job Area
01: Recall
02: Copy
03: Bulk

Settings: off and on

Store Performance Function

This parameter can be used to enable (“on”) or disable (“off”) locking of the
Voice-selection controllers shown below.

Compare Performance Function

Settings: off and on

NOTE This setting applies to all of the following controllers; individual settings are
not supported.
Controllers affected: [-1/NO] and [+1/YES] buttons; [u]/[d]/[l]/[r]
(Cursor) buttons; Voice Category buttons; and Data Dial

NOTE When this parameter is set to “off”, you will be able to use the [-1/NO] and
[+1/YES] buttons, the [u]/[d]/[l]/[r] (Cursor) buttons, and the Data Dial on the
Performance screen only.

File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Utility Job Area
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Utility Job functions
Two functions can be executed from the Utility Job area — Factory Set and Version.

Reference
Performances

01: Factory Set
The Factory Set function can be used to restore the stage piano’s User Memory to its default
condition.
Procedure

Editing Performances
Common Edit Area

1. Press the [UTILITY] button.

01: Chorus Effect

2. On the Utility menu, use the [d] button to select 07: Job, and then press the [ENTER] button.

02: Reverb Effect

3. Use the [u] button to select 01: FactorySet, and then press the [ENTER] button.
4. Use the [-1/NO] and [+1/YES] buttons or the Data Dial to set PowerOn Auto to “off”, and then
press the [ENTER] button.
5. When the Confirmation popup is displayed, press the [+1/YES] button to execute the Factory
Set function.

03: General
04: Name
Part Edit Area

NOTE The Utility menu is the first screen displayed when the [UTILITY] button is pressed.

01: Play Mode

NOTE Before executing this function, the instrument will display the Confirmation popup to confirm that you
wish to proceed (“Are you sure?”). You can press the [+1/YES] button to execute the function or the [-1/
NO] button to return to the previous screen without doing so.

02: Filter/EG

NOTICE
Whenever the Factory Set function is used to restore default settings, all Performance data and Utility
settings stored in the stage piano’s User Memory will be overwritten. Be sure, therefore, to save all
important data and settings on a USB flash-memory device in advance.

03: Effect-A
04: Effect-B
05: Controller
06: Receive Switch
Master Keyboard Area

07: Job selected in Step 2:

Job Area

UTILITY
U07:Job

01: Recall
02: Copy

Press the [ENTER] button.

03: Bulk
Store Performance Function

01: FactorySet selected in Step 3:

Compare Performance Function

UTILITY Job
D01:FactorySet

File Area
01: Save

Press the [ENTER] button.

02: Load
03: Rename

PowerOn Auto set to “off” in Step 4:

04: Delete

Job
FactorySet

PowerOn Auto
Roff

1

2

05: Format
06: Memory Info

Press the [ENTER] button.

Utility Area
01: General

Confirmation popup from Step 5:
3

Are you sure?
[NO]/[YES]
1 Job FactorySet
This shows that you are on the Utility area’s Factory Set screen.

2 PowerOn Auto
This parameter is used to enable (“on”) or disable (“off”) automatic restoration of User Memory to its
default condition whenever the stage piano is turned on. Use the [-1/NO] and [+1/YES] buttons or
the Data Dial to select “on” or “off” as required. Normally, PowerOn Auto should be set to “off”. In
addition, this parameter’s setting is automatically stored when the Factory Set function is executed.

02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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3 Are you sure?

Design of the CP4 STAGE & CP40 STAGE

This message is displayed before executing the Factory Set function. Press the [+1/YES] button to
proceed. Alternatively, press the [-1/NO] button to return to the previous screen.
NOTICE

Reference

If you set PowerOn Auto to “on” before executing the Factory Set function, the function will then execute
automatically whenever you subsequently turn on your stage piano. As this can result in the loss of
important settings and data, we recommend that this parameter normally be set to “off”. If you change the
PowerOn Auto setting from “on” to “off”, you must execute the Factory Set function in this condition to
store the new setting.

Performances
Editing Performances
Common Edit Area
01: Chorus Effect

02: Version

02: Reverb Effect

The Version screen can be used to review the current versions of the stage piano’s boot loader and
firmware in addition to copyright information.

03: General

Procedure

04: Name

1. Press the [UTILITY] button.
2. On the Utility menu, use the [d] button to select 07: Job, and then press the [ENTER] button.
3. Use the [d] button to select 02: Version, and then press the [ENTER] button.

NOTE The Utility menu is the first screen displayed when the [UTILITY] button is pressed.

Part Edit Area
01: Play Mode
02: Filter/EG
03: Effect-A
04: Effect-B

02: Version selected in Step 3:
2

05: Controller

Job
Version

Boot:1.00
Firm:1.00
(C)2013 Yamaha Corp.

06: Receive Switch
Master Keyboard Area

1

3

Job Area

1 Job Version

01: Recall

This shows that you are on the Utility area’s Version screen.
02: Copy

2 Boot: (version number) Firm: (version number)
This shows the current versions of the stage piano’s boot loader and firmware.

03: Bulk
Store Performance Function

3 (C)2013 Yamaha Corp.
This shows the owner of the copyright for the stage piano’s boot loader and firmware.

Compare Performance Function
File Area
01: Save
02: Load
03: Rename
04: Delete
05: Format
06: Memory Info
Utility Area
01: General
02: MIDI
03: Controller
04: MasterComp
05: Master EQ
06: Panel Lock
Utility Job Area
01: Factory Set
02: Version
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Appendix
MIDI
Musical Instrument Digital Interface (MIDI) is a global standard designed to allow performance, voice, and other data to
be transferred between musical instruments. As such, reliable data communication is assured even between musical
instruments and equipment from different manufacturers. In addition to data generated by playing the keyboard or
selecting a Performance, a wide range of other data types — such as tempo and instrument controls — can also be
exchanged via MIDI. Using the powerful functionality provided by this technology, you can not only play other
instruments using your stage piano’s keyboard and controllers, but you can also change pan and reverb settings for
each Part and adjust effect settings. In fact, practically all of the parameters that can be set using the instrument’s control
panel can also be remotely controlled from another MIDI device.
In this section, data and values will be displayed in binary, decimal, and hexadecimal formats. In order to indicate
hexadecimal values, an “H” is displayed in front of or behind the numeric values. Furthermore, “n” is used to represent an
arbitrary integer (or whole number).
NOTE MIDI transmit and receive channels on the CP4 STAGE
and CP40 STAGE are set as follows for each Part.

MIDI Channels
MIDI data can be transmitted and received on one of
sixteen MIDI channels. Therefore, performance data for
up to sixteen different instrument Parts can be
simultaneously exchanged over a single MIDI cable.
MIDI channels are very similar in nature to TV channels,
in that each TV station transmits its broadcasts over a
specific channel. Your TV, for example, receives many
different programs at the same time from different
broadcasters, and you select which program to watch by
choosing the corresponding channel.

CP4 STAGE:
MAIN Part: Channel 1 is used for both transmission and
reception.
LAYER Part: Channel 2 is used for both transmission and
reception.
SPLIT Part: Channel 3 is used for both transmission and
reception.
CP40 STAGE:
MAIN Part: Channel 1 is used for both transmission and
reception.
SPLIT/LAYER Part: Channel 2 is used for both
transmission and reception.

Weather forecast

Supported MIDI message types

News

2

1

News

2

In much the same way, multiple transmitting devices in a
MIDI system can each be set to send data on a separate
channel (i.e., a MIDI Transmit channel), which link with the
system’s receiving devices via MIDI cables. If a receiving
device’s MIDI channel (i.e., a MIDI Receive channel)
matches a MIDI Transmit channel, the receiving device
will produce sound in response to the data sent by the
corresponding transmitting device.

Broadly speaking, MIDI messages can be divided into
two groups — channel messages and system messages.
A description of each different type of channel message
and system message supported by the CP4 STAGE and
CP40 STAGE is provided below. Further details can be
found in the MIDI Data Format and MIDI Implementation
Chart sections of the Data List pdf.

Channel Messages
MIDI channel messages contain performance-related
information, and each one is sent on a specific MIDI
channel.

MIDI cable

 Note On & Note Off

CP4 STAGE or CP40 STAGE

MIDI keyboard or synthesizer
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Note On and Note Off messages are generated when a
keyboard is played. Specifically, a Note On message is
produced when a key is pressed; a Note Off message,
when it is released. Each of these messages contains a
specific note number corresponding to the key that was
pressed, in addition to a velocity value indicating how
hard the key was struck. Receivable MIDI note numbers
range from 0 (C-2) to 127 (G8), with middle C (C3)
represented by 60. Receivable velocity values, which are
contained within Note On messages only, range from 1 to
127.
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 Control Change

Soft Pedal (Control No. 67)

MIDI Control Change messages are used to control
volume, stereo panning, and many other parameters, and
as shown below, each message type has its own unique
control number.

Soft Pedal messages can be used to modify the sound of
notes in the same way as a piano’s Soft pedal. Setting a
value between 64 and 127 turns soft on, reducing the
volume and slightly softening the timbre; meanwhile,
values between 0 and 63 turn it off.

Bank Select MSB (Control No. 0)
Bank Select LSB (Control No. 32)

Release Time (Control No. 72)

Bank Select MSB and LSB messages are used to
remotely select Performances and Part Voices from
another MIDI device. The selection will not, however,
become effective until a Program Change message is
subsequently received.

Release Time messages can be used to adjust the AEG
release time for each Part. Values of 0 to 127 correspond
to offset values of -64 to +63, which are used to reduce or
increase the release time accordingly.

Data Entry MSB (Control No. 6)
Data Entry LSB (Control No. 38)

Decay Time messages can be used to adjust the AEG
decay time for each Part. Values of 0 to 127 correspond
to offset values of -64 to +63, which are used to reduce or
increase the decay time accordingly. The larger the
value, the longer it takes for the sound to decay after the
initial attack.

Data Entry MSB and LSB messages are used to set a
value for the parameter selected using RPN MSB and
RPN LSB messages (see below). The actual value to be
set is determined by combining the MSB and LSB values.

Main Volume (Control No. 7)
Main Volume messages can be used to adjust the volume
of each Part. Setting a value of 127 produces maximum
volume, while 0 silences the Part in question. These
messages can be useful when adjusting the relative
volumes of each Part.

Pan (Control No. 10)
Pan messages can be used to adjust the stereo panning
of each Part. Setting a value of 127 moves the sound fully
to the right, while 0 moves it to the far left and 64 places it
in the middle of the stereo field.

Expression (Control No. 11)
Expression messages can be used to change the level of
expression or intonation of each Part. Setting a value of
127 produces maximum volume, while 0 silences the Part
in question. These messages can be useful when you
wish to adjust the volume to add expression during
performances.

Hold 1 (Control No. 64)
Hold 1 messages can be used to modify the sound of
notes in the same way as a piano’s Sustain (Damper)
pedal. Setting a value between 64 and 127 turns sustain
on (pedal operated), while values between 0 and 63 turn
it off (pedal released). When turned on, notes will sustain
longer than normal after the corresponding Note Off
message is received. The CP4 STAGE and CP40 STAGE
turn sustain fully off only for a Hold 1 value of 0, and
values from 1 to 127 result in increasingly longer sustain
times.

Sostenuto (Control No. 66)
Sostenuto messages can be used to modify the sound of
notes in the same way as a piano’s Sostenuto pedal.
Setting a value between 64 and 127 turns sostenuto on,
while values between 0 and 63 turn it off. If sostenuto is
turned on while the note generated by a specific Note On
message is playing, it will be sustained longer until the
corresponding Note Off message is received.
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Decay Time (Control No. 75)

Vibrato Rate (Control No. 76)
Vibrato Rate messages can be used to adjust the speed
of each Part’s vibrato effect. Values of 64 leave the Part’s
speed setting unchanged; values larger than 64 produce
faster vibrato speeds and vice-versa.

Vibrato Depth (Control No. 77)
Vibrato Depth messages can be used to adjust the
intensity of each Part’s vibrato effect. Values of 64 leave
the Part’s depth setting unchanged; values larger than 64
produce a more intense vibrato effect and vice-versa.

Vibrato Delay (Control No. 78)
Vibrato Delay messages can be used to adjust how long
after playing a key the onset of vibrato is delayed for
each Part. Values of 64 leave the Part’s delay setting
unchanged; values larger than 64 produce longer delay
times and vice-versa.

Effect 1 Depth (reverb send level)
(Control No. 91)
Effect 1 Depth messages can be used to adjust the
reverb effect’s send level.

Data Increment (Control No. 96)
Data Decrement (Control No. 97)
Data Increment and Data Decrement messages can be
used to increment and decrement pitch bend sensitivity
in steps of 1 (assuming that the parameter has been set
in advance using RPN messages (see below)).

RPN LSB (registered parameter number LSB)
(Control No. 100)
RPN MSB (registered parameter number MSB)
(Control No. 101)
RPN LSB and MSB messages are used primarily to
facilitate the setting of offset values for pitch bend
sensitivity, tuning, and other Part parameters. In specific
terms, the parameter to be modified is first selected
using these messages, and the above-mentioned Data
Increment and Data Decrement messages are then used
to change the parameter setting. It should be noted that,
once an RPN has been set, all subsequent data entry
messages on the same channel will affect the
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corresponding parameter. After setting a parameter
based on these messages, therefore, it is wise to set the
RPN to Null (7FH, 7FH) in order to avoid unexpected
changes.
Your CP4 STAGE or CP40 STAGE supports selection of
the following parameter using RPN LSB and MSB
messages.
RPN
MSB

RPN
LSB

Parameter

00H

00H

Pitch Bend Sensitivity

7FH

7FH

RPN Null

 Program Change
MIDI Program Change messages are used to select a
different Performance. When combined with Bank Select
MSB and LSB messages, furthermore, it is possible to
select Performances from any of the instrument’s memory
banks via MIDI. A full list of Performances can be found
in the Data List pdf.
NOTE Program change numbers (0 to 127) are one less than
the corresponding number in the Data List (pdf). To
select program No. 16, for example, you would need to
send a message with program change number 15.

 Pitch Bend
 Channel Mode Messages
2nd byte

3rd byte

Message

120

0

All Sound Off

121

0

Reset All Controllers

123

0

All Notes Off

All Sound Off (Control No. 120)
All Sound Off messages are used to silence all sounds
being generated by the instrument’s Parts. MIDI Channel
messages such as Hold 1 and Sostenuto are retained.

Reset All Controllers (Control No. 121)
A Reset All Controllers message is used to return each of
the following controllers to their default values.
Controller

Default value

Pitch Bend

0 (center position)

Expression

127 (maximum)

Hold 1

0 (off)

Sostenuto

0 (off)

Soft Pedal

0 (off)

RPN

Number not specified; internal data will
not be changed.

All Notes Off (Control No. 123)
An All Notes Off message is used to turn off all notes for
each Part. If, however, Hold 1 or Sostenuto is turned on at
this time, notes will continue to play until these controllers
are turned off.

Omni Mode Off (Control No. 124)
Omni Mode Off messages have the same effect as an All
Notes Off message.

Pitch Bend messages are continuous controller
messages that allow the pitch of designated notes to be
raised or lowered by a specified amount over a specified
duration.

System Messages
Rather than being associated with a specific channel,
MIDI system messages are used for synchronization of
devices and other behavior of the instrument as a whole.

 System Exclusive Messages
Used to perform bulk data dumps and to change
parameters, MIDI system exclusive messages contain a
device number, allowing them to operate as if on a
unique MIDI channel. In order for this type of message to
be exchanged between devices, both the sending and
receiving devices must be set to the same device
number. Using system exclusive messages, you can
control practically every parameter on your stage piano
from another MIDI device.

 System Realtime Messages
Active Sensing (FEH)
Active Sensing is a type of MIDI message used to
prevent unexpected results in the event that a MIDI cable
is disconnected or damaged while the instrument is
being played. Upon the receipt of an Active Sensing
message, the stage piano will begin to monitor the status
of connected MIDI cables. If no MIDI data is received
over the next 300 ms, the stage piano will conclude that a
problem has occurred with a MIDI cable, and in
response, it will act as if an All Notes Off message and a
Reset All Controllers message had been received.

Timing Clock (F8H)
Omni Mode On (Control No. 125)
Omni Mode On messages have the same effect as an All
Notes Off message.
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Timing Clock messages are transmitted at a fixed interval
(i.e., 24 times per 1/4 note) to synchronize connected
MIDI instruments. Use the Sync parameter from the Utility
area’s MIDI screen to specify whether the instrument’s
internal clock or Timing Clock messages received via the
MIDI [IN] terminal should be used for synchronization.
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